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INTRODUCTION 
The User’s Guide describes the detailed steps necessary to calculate credits and credit obligations for 
credit and debit sites, respectively, for the Nevada Conservation Credit System. 

WHO USES THE USER’S GUIDE 

The User’s Guide is intended for use by the Credit System Administrator, Technical Support Providers 
and Verifiers to calculate credits and credit obligations, and is currently designed with these users in 
mind. This version of the User’s Guide has been made available to the general public, along with data 
required to use the User’s Guide (see Required Data in the Desktop Analysis section), to allow testing of the 
User’s Guide steps. You are encouraged to send any feedback to the Credit System Administrator.  

Using the User’s Guide requires substantial knowledge of sage-grouse biology, moderate GIS capabilities, 
and extensive experience with field data collection methods including identification of Great Basin plant 
species. This expertise may be provided by a single individual or team. In addition, there are specific 
software requirements (as defined at the beginning of each section), including an ESRI ArcGIS license 
with the Spatial Analyst extension and Microsoft Excel 2000 or later. 

HOW TO USE THE USER’S GUIDE 

The User’s Guide is organized into three major steps summarized in Figure 1. All steps should be 
executed in sequence listed below, unless the user has extensive experience and a deep understanding of 
the steps, in order to ensure accurate calculation of credits and credit obligations, and take advantage of 
efficiencies built into the design of the User’s Guide. 

1. Desktop Analysis: The Desktop Analysis should be completed first, because a) the Desktop 
Analysis informs the sampling protocol used in the field analysis, and b) the Desktop Analysis 
pre-screens credit project sites to ensure that they meet the credit site eligibility requirements (see 
the Credit System Manual for more on credit site eligibility) before investing significantly more 
resources to collect field data. 

2. Field Data Collections Method: The Field Data Collection Method can be conducted after the 
Desktop Analysis. Map units and transect locations may need to be revised during the field visit, 
which would require portions of the Desktop Analysis to be rerun. 

3. Credit/Credit Obligation Calculation: The complete Credit/Credit Obligation calculation can 
only be performed after completing both the Desktop Analysis and Field Data Collection 
Methods.  It is possible to generate some partial estimates of the credit/credit obligation 
calculation that may be of interest in particular situations (e.g., projected local-scale function, site-
scale habitat function) once required data for those elements are available. 
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Figure 1. Workflow diagram for calculating credits/credit obligations for the Conservation Credit System 

HOW THE USER’S GUIDE RELATES TO THE MANUAL AND HABITAT QUANTIFICATION 
TOOL 

The User’s Guide operationalizes steps, and applies the policy and technical methods defined in the 
Credit System Manual and Habitat Quantification Tool (HQT) Methods Document in order for Technical 
Support Providers, Verifiers and the Credit System Administrator to consistently and efficiently calculate 
credits and credit obligations. 

OPERATIONALIZE STEPS DEFINED IN THE MANUAL 

The User’s Guide describes the detailed steps necessary to consistently and efficiently perform portions of 
the process to generate credits and purchase credits under the Credit System. Section 3: Credit System 
Operations of the Credit System Manual summarizes the process, and the portions of the process covered 
by the User’s Guide are described below. 

For Credit Projects 
The User’s Guide covers step D1 in Section 3.1: Generating Credits of the Nevada Conservation Credit 
System Manual (Figure 2). Before beginning the User’s Guide, a Project Validation Checklist should be 
submitted and approved by the Administrator. Review Section 3: Credit System Operations of the Manual 
for more information. 

 
Figure 2. Overview of the process steps to generate credits 

For Debit Projects 
The User’s Guide covers step B2 in Section 3.2: Acquiring Credits of the Nevada Conservation Credit 
System Manual (Figure 3). Before beginning the User’s Guide, the Credit Obligation Statement with 
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project design information should be submitted to the Administrator. Review Section 3: Credit System 
Operations of the Manual for more information. 

 
Figure 3. Overview of the process to calculate credit obligation and acquire credits 

APPLY POLICY AND TECHNICAL METHODS DEFINED IN THE MANUAL AND HQT 
METHODS DOCUMENT 

The User’s Guide describes the detailed steps necessary to consistently and efficiently apply the policy 
and technical methods defined throughout the Credit System Manual and HQT Methods Document 
when calculating credits and credit obligations. A summary of the Manual and HQT are described below. 

Credit System Manual 
The Credit System Manual describes the policy and technical requirements regarding the calculation, 
transaction, and tracking of credits and debits in the Credit System. Section 2: Policy and Technical Elements 
of the Credit System Manual contains the policy and technical requirements, and is organized by the 
following sections: 

2.1 Program Governance: Describes the governance, enforcement, accounting and adaptive 
management procedures. 
2.2 Habitat Quantification and Credit and Debit Calculation: Describes how to calculate credits, 
debits and credit obligations. 
2.3 Credit Additionality Provisions: Describes requirements that ensure credit projects provide 
benefits beyond those that would be achieved if the project and associated management actions 
had not taken place. 
2.4 Credit Durability Provisions: Describes requirements that ensure credit projects are 
producing expected outcomes for their entire duration. 
2.5 Credit Obligation Provisions and Credit Investment Strategies: Describes requirements that 
ensure credit obligation projects offset the direct and indirect impacts of debit projects. 

Habitat Quantification Tool Methods Document 
The HQT Methods Document defines relevant habitat selection criteria corresponding to sage-grouse 
survival and reproduction at multiple spatial scales. The HQT measures and delineates habitat selection 
criteria using the following four orders, which are defined in substantial detail in Section 3: Habitat 
Quantification Methods and Attributes of the HQT Methods Document:1 

Range-wide: the range for sage-grouse in Nevada;  
Landscape Scale: management areas that have been identified as important for maintaining the 
species at statewide scales (e.g., Priority Habitat Management Areas, General Habitat 
Management Areas, and Other Habitat Management Areas) and the availability of seasonal 
habitats; 
Local Scale: habitat conditions and anthropogenic factors that affect sage-grouse use of, and 
movement between, seasonal use areas within and surrounding the project site; 
Site Scale: habitat conditions at the site of the proposed activities. 

                                                           
1 Stiver, S.J., E.T Rinkes, and D.E. Naugle. 2010. Sage-grouse Habitat Assessment Framework. U.S. Bureau of Land Management. 
Unpublished Report. U.S. Bureau of Land Management, Idaho State Office, Boise, Idaho. 
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WHAT PRINCIPLES GUIDE THE CALCULATION OF CREDITS AND CREDIT OBLIGATIONS 
WHEN ADDITIONAL CLARITY IS NEEDED 

The following principles guided the development of the process documented in this User’s Guide to 
calculate credits and credit obligations. Users should reference these principles if they need clarity or 
additional guidance when calculating credits or credit obligations for any specific project. 
1. Reflect the concepts and science of the Habitat Quantification Tool methods document accurately 
2. Quantify both direct and indirect impacts of debit projects 
3. Acknowledge the spatially explicit and cumulative nature of impacts to sage-grouse habitat 
4. Evaluate all projects by comparing baseline and post-project condition 
5. Strive for replicability and consistency 
6. Increase ease of use and decrease cost whenever possible without reducing accuracy and 

replicability 
7. Ensure all credit projects generate benefits to sage-grouse proportionate to the impact being offset 
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DESKTOP ANALYSIS  

TOOLS REQUIRED 

In order to complete the Desktop Analysis, the following tools are required: 

 ArcMap (ESRI) version 10.1 or later—Basic (ArcView) license or better required  

▫ Spatial Analyst extension license 

 Python 2.7.2 or later (automatically installed with ArcMap) 

 Microsoft Excel (2000 or higher) 

 Credit or Debit Project Calculator Version 1.3 

 Management Plan and Validation Checklist (credit projects only) 

 Recommended: Nevada Conservation Credit System Manual and HQT Scientific Methods 
Document for reference 

DATA REQUIRED  

The following data should be acquired before beginning the Desktop Analysis:  

1. Download and extract the compressed file NevadaDataPackage_v1_3.zip to a location on the 
computer’s hard drive. We recommend saving the Nevada Data Package locally, as opposed to 
an external server, to improve processing time. The Nevada Data Package is available at: 
https://dcnrftp.ndep.nv.gov.   

Username: SET_public 
Password: SET@1234   

In this folder, you will find (1) the Anthropogenic features geodatabase, (2) the Layer Files folder, 
(3) the Python Scripts folder, (4) the Required Data Layers geodatabase, (5) the Credit Project 
Toolbox, (6) the Credit Project Reclaim Toolbox, (6) the Debit Project Toolbox, and (7) the 
NV_CCS_Map_Template map document.  

 Anthro_Features.gdb is a file geodatabase containing existing anthropogenic features to be used 
to assist in delineating anthropogenic features: 

▫ Mines: Federal mine locations derived from Mineral Resource Data System (MRDS) data. 

▫ Oil_Gas: Federal oil and gas well locations derived from Automated Fluid Mineral Support 
System (AFMSS) data dated 12/2012. 

▫ Powerlines: Empty feature class to allow users to more easily delineate powerlines.  

▫ Renewable: Geothermal leases dated 2013. 

▫ Roads: State, federal, and county roads compiled by Nevada Department of Transportation 
(NDOT). 

▫ Towers: Communications tower locations derived from FCC data. 

▫ Urban: Boundaries of census blocks in Nevada categorized based on a Wikipedia search of 
all cities/townships. 

https://dcnrftp.ndep.nv.gov/
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 Layer_Files Folder: Includes layer files that may be used to standardize the symbology of 
outputs of the Desktop Analysis. Instructions for applying symbology to layers using layer files 
are provided throughout the User’s Guide at appropriate steps. 

 Python Scripts Folder: Contains text of the Python scripts used to generate the Desktop Analysis 
Tools, to be used for reference if desired.  

 Required_Data_Layers.gdb contains the following data:  

▫ Anthropogenic Disturbance Attribute Table (Anthro_Attribute_Table): This table provides 
the indirect-effect weights and distances of anthropogenic features. Data in this table is also 
provided in Table 1, further below. 

▫ Distance to Brood-Rearing Habitat (Dist_Brood): This raster layer represents habitat 
function associated with distance to brood-rearing habitats in Nevada. Use to calculate the 
Distance to Brood-Rearing Habitat modifier. 

▫ SEP Management Categories Map (Mgmt_Cat): This feature layer delineates the boundaries 
of Sagebrush Ecosystem Program (SEP) Management Categories in Nevada. Use for 
informing the Credit System’s Mitigation Ratio. 

▫ Biological Significant Units (NV_BSU): This feature class delineates the boundaries of the 
Biological Significant Units in Nevada. 

▫ Nevada Disturbance Response Groups (NV_DRG) 2: This feature class delineates the 
boundaries of ecological sites that have been grouped into identified disturbance response 
groups. 

▫ Priority Conservation Areas (NV_PCA): This feature class delineates the boundaries of 
Priority Conservation Areas, which are defined as the intersection between Sagebrush Focal 
Areas and (SFA) and Priority Habitat Management Areas (PHMA) in Nevada.  

▫ Population Management Units (NV_PMU): This feature class delineates the boundaries of 
the NDOW Population Management Units in Nevada. 

▫ WAFWA Management Zones (NV_WAFWA): This feature class delineates the boundaries 
of the WAFWA Management Zones in Nevada.  

▫ Precipitation Regime (Precip): This raster layer is reclassified such that areas with less than 
25.4 cm of precipitation are categorized as arid (coded as ‘0’), and areas with greater than 
25.4 cm are categorized as mesic (coded as ‘1’). It is derived from the 30-year normal PRISM 
dataset available at http://prism.oregonstate.edu/normals/. Use for identifying the 
precipitation regime of individual map units.  

▫ Breeding Habitat Suitability Index (Spring_HSI): This raster dataset provides an index of 
local-scale habitat functionality for sage-grouse in Nevada during the spring season, which 
corresponds to the breeding life history period for sage-grouse. 

▫ Late Brood-rearing Habitat Suitability Index (Summer_HSI): This raster dataset provides 
an index of local-scale habitat functionality for sage-grouse in Nevada during the summer 
season, which corresponds to the late brood-rearing life history period for sage-grouse. 

▫ Over-Wintering Habitat Suitability Index (Winter_HSI): This raster dataset provides an 
index of local-scale habitat functionality for sage-grouse in Nevada during the winter 
season, which corresponds to the over-wintering life history period for sage-grouse. 

 The CreditToolbox contains a series of tools necessary to complete an assessment for a credit 
project that does not propose to modify current anthropogenic features.  

                                                           
2 Disturbance Response Grouping of Ecological Sites Increases Utility of Ecological Sites and State-and-Transition Models for 
Landscape Scale Planning in the Great Basin. Tamzen K. Stringham, Patti Novak-Echenique, Devon K. Snyder, Sarah Peterson, and 
Keirith A. Snyder. Rangelands 2016 38 (6), 371-378 

http://prism.oregonstate.edu/normals/
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 The CreditToolbox_Reclaim contains a series of tools necessary to complete an assessment for a 
credit project that proposes to reclaim (i.e., completely remove) current anthropogenic features.  

 The DebitToolbox contains a series of tools necessary to complete a debit project assessment.  

 The Nevada CCS Map Template (.mxd) can be used as a starting point for completing the 
Desktop Analysis on either Credit or Debit projects; use of the template is recommended but not 
required. 

2. Download supplemental data sources: 

▫ NAIP (National Agricultural Imagery Program) imagery: Use as a supplemental data 
source for delineating map units, detecting additional disturbance and verifying 
disturbance from GIS layers. True Color images are available in seamless statewide 
coverage from the following ArcGIS Server site: 
https://gis.apfo.usda.gov/arcgis/rest/services.  

a) To install this ArcServer: click the Add Data button> from the look in menu navigate to 
GIS Server (toward the bottom)> Add ArcGIS Server> Use GIS Services> Next> Enter 
https://gis.apfo.usda.gov/arcgis/rest/services into the internet server box> Finish.  

b) To use the images from the above server: click the Add Data button> navigate to GIS 
Servers> arcgis on gis.apfo.usda.gov> NAIP> Nevada_2015_1m_NC. 

In addition, other aerial imagery sources may be used (e.g., base layers available through 
ArcMap (File>Add Data> Add Basemap).  

▫ Synth Map 2008 (or most recent version):  Use as a supplemental data source for 
delineating map units. Available at http://heritage.nv.gov/node/164. Download the ‘Map 
High Resolution’ and unzip the folder to the desired location. Add the layer file (.lyr) and 
set the data source as the shapefile (.shp). 

▫ SSURGO (Soil Survey Geographic Database): Use the web soil survey data to assist with 
delineating map units based on ecological site descriptions. Available at 
http://websoilsurvey.sc.egov.usda.gov/App/WebSoilSurvey.aspx. Download soils data 
either by navigating to appropriate county and select the most appropriate soils survey 
based on description or by defining area of interest (AOI) and downloading data for the 
AOI. 

▫ USGS Topographic Maps: Use for assistance delineating map units. In ArcMap, go to File> 
‘Add data from ArcGIS Online’. Search for USA Topo. Click “Add” for most recent version. 
Also available at http://nationalmap.gov/ustopo/. 

3. Acquire field data sheets and guidance for the scorecards, located in the Appendices. 

4. Acquire the Proposed Surface Disturbance or Credit Project Boundary shapefile or feature 
layer. This is the area that is being proposed as the debit or credit project, and should be provided 
by the project proponent.  

a. If the proposed surface disturbance or credit project boundary shapefile is not provided, 
follow the steps below to create it. Ensure you have sufficient information to accurately 
digitize this layer. 

For credit projects:  

https://gis.apfo.usda.gov/arcgis/rest/services
https://gis.apfo.usda.gov/arcgis/rest/services
http://heritage.nv.gov/node/164
http://websoilsurvey.sc.egov.usda.gov/App/WebSoilSurvey.aspx
http://nationalmap.gov/ustopo/
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1. Create a new feature class, type— “Polygon Features”. Name this file 
Credit_Project_Boundary. 

2. Start an editing session by right-clicking on the layer in the Table of Contents, clicking 
‘Edit Features’, then ‘Start Editing’.  

3. Digitize the area of land on which credits can be generated. For example, areas not 
designated within management categories are to be excluded as well as lands not 
eligible to be included in the project. Be sure to save edits and stop editing when done. 

For debit projects:  

1. Create a new feature class, type— “Polygon Features”. Name this file 
Proposed_Surface_Disturbance. 

2. Digitize the outer extent of the proposed surface disturbance, creating separate 
features within the same feature class for each anthropogenic feature subtype 
described in Table 1. Be sure to save edits and stop editing when done. 

5. You will need to acquire the Dist_Lek layer from the Nevada Department of Wildlife by 
submitting a Data Request Form, available from the NDOW website at 
http://www.ndow.org/Nevada_Wildlife/Maps_and_Data/Data/. See step D8 for more 
information. 

 

http://www.ndow.org/Nevada_Wildlife/Maps_and_Data/Data/
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ANTHROPOGENIC FEATURES EVALUATED DURING THE DESKTOP ANALYSIS 

Table 1 contains the definitions and indirect-effect weights and distances of anthropogenic features. This table is referenced throughout the Desktop 
Analysis to evaluate impacts from existing and proposed anthropogenic features. It is provided here for quick reference. 

Table 1. Anthropogenic Features Considered in the Nevada Conservation Credit System 

TYPE SUBTYPE TYPE  
CODEt 

SUBTYPE  
CODEt 

WEIGHT 
(%) 

DISTANCE 
(Meters) DEFINITION 

Towers  

Communications Towers Communications 75% 6,000 m 
Tall structures designed to support antennas for 

telecommunications and broadcasting. 

Meteorological Towers Meteorological 75% 6,000 m 
Tall structures designed to support meteorological 

measuring instruments, including those installed to test 
the feasibility of wind farms. 

Powerlines* 
 

 Transmission -  

Distribution 
Powerlines Transmission_Distribution 75% 6,000 m 

Major and minor electrical power transmission and 
distribution lines with cross members, supporting arms, 

etc. Do not include buried transmission lines. 

Monopole Powerlines Distribution_Monopole 25% 6,000 m 
Monopole distribution lines with no cross members, 

supporting arms, etc. or of a construction that would not 
support raven occupancy 

Mines 

Active - Large  Mines Active_Large 100% 6,000 m Total area of 60 acres or more, active 

Active - Med or 
Small 

Mines Active_Small 100% 3,000 m Total area less than 60 acres, active 

Inactive - Large Mines Inactive_Large 50% 1,000 m 

Total area of 60 acres or more, inactive (no longer 
removing material from the ground and very little, if any, 

associated human activity. Some infrastructure, hard 
structures, or facilities are still present on the site. Do not 
include reclaimed mines or non-reclaimed mines with no 

remaining infrastructure).  

Inactive - Med or 
Small 

Mines Inactive_Small 10% 1,000 m Total area less than 60 acres, inactive (see above definition 
of inactive). 
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Oil & Gas 
Wells 

Producing Oil_Gas Producing 100% 3,000 m Activity is occurring at the well pads. 

Inactive Oil_Gas Inactive 0% 0 m Activity is not occurring at the location. 

Pipelines Pipeline Pipelines Pipelines n/a n/a 

Pipelines are not captured within the context of 
anthropogenic features on the landscape within the HQT. 
This is primarily due to lack of literature and the temporal 

nature of these features at this point in time. Do not 
digitize pipeline features. 

Urban, 
Suburban,  
Ex-Urban 

Development 

Med - High Urban High 100% 6,000 m 
Incorporated cities or unincorporated towns with a 

population of 10,000 residents or greater according to the 
latest population data from the State Demographer. 

Low Urban Low 75% 3,000 m 
Incorporated cities or unincorporated towns with a 

population of less than 10,000 residents according to the 
latest population data from the State Demographer. 

Roads 

Interstate Roads Interstate 100% 6,000 m Roads with an Interstate functional classification as 
defined by the Federal Highway Administration. 

High Use – Paved 
or Improved; 
Commercial  

Roads High_Use 100% 3,000 m 

Roads with an Arterial or Major Collector functional 
classification as defined by the Federal Highway 

Administration. Roads to commercial facilities (e.g., 
mines, geothermal plants), which may not necessarily be 

classified by the Federal Highway Administration. 

Low Use – 
Improved; Local 

Roads Low_Use 25% 1,000 m 
Roads with a Minor Collector or Local functional 
classification as defined by the Federal Highway 

Administration. 

Renewable 

Solar Renewable Solar 25% 1,000 m Utility-scale solar, geothermal, or wind farm projects and 
any associated above-ground facilities, excluding 

transmission lines connecting to the main grid (categorize 
as ‘Power Lines’). Do not include reclaimed projects or 

non-reclaimed projects with no remaining infrastructure. 

Geothermal Renewable Geothermal 100% 6,000 m 

Wind Renewable Wind 25% 6,000 m 
*The project proponent may request to review and adjust the weight and distance criteria based upon powerline height, construction, perch deterrents 
or other site-specific factors. Any requests must be submitted to the Administrator and approved by the Scientific Committee. 

t When digitizing anthropogenic features or categorizing proposed surface disturbance, the Type and Subtype attributes must be exactly the same as the 
Type and Subtype codes provided in this table, including capitalization.
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DEBIT PROJECTS: GUIDANCE FOR COMPLETING THE DESKTOP ANALYSIS 

This section describes the process required to assess a debit project. Tools provided in the Debit Toolbox 
are intended to facilitate the assessment of debit projects. User input is required. Please read each step 
carefully. User tips are provided for each step, some of which may be required to successfully complete 
the step in certain circumstances. We recommend reviewing this guide in its entirety before starting. 

Each tool will add one or more layers to the default file geodatabase. Subsequent tools require these 
layers in order to run. Do not modify or rename these layers. Only outputs that are added to the Table of 
Contents and map display should be edited. 

If you have already delineated map units and/or current anthropogenic features, you will be able to use 
those layers in this process. You do not need to recreate those layers. If you have already delineated map 
units, skip step D5. If you have already digitized current anthropogenic features, skip step D7. However, 
ensure those layers were created in accordance with the guidance in those steps. In step D9, identify the 
location of the map units and/or current anthropogenic features layers when running Debit Tool 4 
according to the instructions in that step. It is important that a layer named “Current_Anthro_Features” 
does not already exist in the default geodatabase for the project; this layer should be located in a separate 
geodatabase. 

For a quick reference guide to the tools and inputs required to complete the Desktop Analysis for debit 
projects, refer to Appendix 3. Quick Reference Guide: Debit Projects. 

D1.  Create project folder, project geodatabase, and map document  

D1.1 In ArcCatalog, create a new folder for the project. Name this folder following the convention 
ProjectName_YYYYMMDD. 

D1.2 Within the folder, create a new File Geodatabase (.gdb) by right-clicking on the folder and 
selecting ‘New’ > ‘File Geodatabase’. Give it the same name as the project folder.  

D1.3 Open NV_CCS_Map_Template (.mxd), located in the Nevada Data Package, and save a 
copy of the map document within the project folder. Give it the same name as the project 
folder.  

D1.4 If necessary, add the relevant toolbox to ArcToolbox by right-clicking on the parent 
ArcToolbox  (         ) in the ArcToolbox window and selecting ‘Add Toolbox’. Navigate to the 
Toolbox and click ‘Open’. The toolbox should now be available in the list of toolboxes. When 
working from The Nevada CCS Map Template, all toolboxes should already be available. 

D1.5 In ArcMap, open the Catalog window ( ), navigate to the new geodatabase, right click on 
it and select ‘Make Default Database’.  

  
Figure 4: Structure of the project folder 

You will submit this Project Folder as a zipped folder (.zip) to the Credit System 
Administrator along with the Project Calculator. 
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Tips 
 When creating folder names and file names, use only letters, numbers, and underscores. Do not 

use other characters. Do not start file names with a number. Some tools will not run properly if 
there are periods, hyphens, or other symbols in the folder or file names. 

D2. Run Debit Tool 1 
[ArcToolbox > DebitTools > Debit Tool 1] 
 Project Geodatabase = the default project geodatabase for this project. 
 Proposed Surface Disturbance = the area that is being proposed as the debit project, 

provided by the project proponent. If no shapefile was provided, see step 4 in the Data 
Required section to create this layer. 

 Nevada Data Package = the parent folder of the Nevada Data Package, named 
NevadaDataPackage_v1_3. 

 
Figure 5. Debit Tool 1 interface 

Tips 
 If the Proposed_Surface_Disturbance provided by the project proponent is represented by 

multiple shapefiles, use the Merge tool to merge the shapefiles into a single feature class.  

[ArcToolbox> Data Management> General> Merge]  
 Input Datasets = All shapefiles representing the Proposed_Surface_Disturbance, 
 Output Dataset = Proposed_Surface_Disturbance, 
 Field Map = leave as default. 

 Overlapping polygons must be removed from the Proposed_Surface_Disturbance layer 
provided by the project proponent before running Debit Tool 1. Use the Intersect tool to 
determine if the layer contains overlapping polygons.  

[ArcTools> Analysis> Overlay> Intersect]  
 Input Features = Credit_Project_Boundary or Proposed_Surface_Disturbance 
 Output Feature Class = append ‘_Merged’ to feature class name 
 Join Attributes = ALL,  
 XY Tolerance = blank,  
 Output Type = INPUT.  
 If overlapping polygons are present, remove any areas of overlap: In an editing session, 

select an overlapping polygon. Select the Clip tool in the Editor toolbar (Editor> Clip). A 

~\Proposed_Surface_Disturbance 

~\NevadaDataPackage_v1_3 

~\ProjectName_YYYYMMDD\ProjectName_YYYYMMDD.gdb 
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dialog box will pop up. Leave the Buffer Distance = 0.0 and select ‘Discard the area that 
intersects’, then click OK. Any polygon portions overlapping the selected polygons will be 
deleted. Repeat for all overlapping polygons. Consult the project proponent if unsure about 
how to categorize overlapping areas. 

D3.  Categorize the Type & Subtype of the Proposed_Surface_Disturbance_Debits layer 

D3.1 In the Table of Contents window, right-click on the Proposed_Surface_Disturbance_Debits 
layer and open the attribute table.  

D3.2 Start an editing session by right-clicking on the Proposed_Surface_Distubance_Debits layer 
in the Table of Contents and selecting ‘Edit Features > Start Editing’. 

D3.3 Review the features provided by the project proponent, and edit as needed. Ensure that the 
outer extents of all proposed anthropogenic features are digitized correctly and all pre-
populated data is accurate. 

D3.4 Populate or update the ‘Type’ and ‘Subtype’ fields for each feature based on the descriptions 
in Table 1. The Proposed_Surface_Disturbance file provided by the project proponent will 
likely contain field codes analogous to the ‘Type’ and ‘Subtype’ fields populated with 
information from Table 1. Work with the project proponent to re-categorize the layer using 
those field codes if necessary. 

D3.5 For anthropogenic features permitted for term impacts, populate the ‘Term’ field with the 
four-digit year that the activity at the anthropogenic feature will cease (estimate this year if 
unsure). Populate the ‘Rehab’ field with the four-digit year that the surface disturbance will 
be rehabilitated to pre-project condition.  

D3.6 For anthropogenic features permitted for permanent impacts, input ‘9999’ in the ‘Term’ and 
‘Rehab’ fields. 

D3.7 Save the edits and stop editing when done. 

 
Figure 6: Example Completed Attribute Table for 'Proposed_Surface_Disturbance_Debits' Layer 

Tips 
 For debit projects with multiple debit terms, consult with the Credit System Administrator to 

estimate the credit obligation at each phase of the project. 

D4. Run Debit Tool 2 
[ArcToolbox > DebitTools > Debit Tool 2] 
 Project Geodatabase = the default project geodatabase for this project. 
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 Nevada Data Package = the parent folder of the Nevada Data Package, named 
NevadaDataPackage_v1_3. 

 
Figure 7. Debit Tool 2 interface 

D5. Divide Map_Units layer into discrete map units & populate attribute table 

D5.1 Open the attribute table of the Map_Units layer. 

D5.2 Start an editing session by right-clicking on the layer in the Table of Contents, clicking ‘Edit 
Features’, then ‘Start Editing’. 

D5.3 Using the Cut Polygon tool (  ) in the Editor Toolbar, delineate map units in the 
Map_Units layer. See Appendix 1. Guidance for Delineating Map Units for detailed 
information. 

D5.4 Name map units numerically and record the name in the ‘Map_Unit_ID’ field. Map units 
that appear to be very similar, but not adjacent to each other, can receive the same numerical 
name and be considered a single map unit. In the field, a visual walk-through should 
confirm this is the case. 

D5.5 Name each map unit by providing a short description, typically associated with the major 
vegetation type, in the ‘Map_Unit_Name’ field. 

D5.6 For any map units that are meadows, populate the ‘Meadow’ attribute with ‘Altered’ or 
‘Unaltered’. For all other map units, populate the ‘Meadow’ attribute with ‘No Meadow’.  

▫ Unaltered meadows are defined at naturally occurring wetland complexes, dominated 
by wetland vegetation and soils (e.g. stringer meadows, springs, seeps) where the 
hydrology has been minimally altered or is currently not being managed. 

▫ Altered meadows are defined as receiving either controlled irrigation, where the 
hydrology is currently being altered or managed (e.g. diversions, spreaders), or where 
the landscape is being functionally altered. 

D5.7 Populate the ‘Precip’ field for each map unit with the correct precipitation regime from the 
Precip layer. Record if the map unit falls in the ‘Arid’ or ‘Mesic’ precipitation regime. If a 
map unit spans both precipitation regimes, record the dominant regime or split the map unit 
into two map units.  

D5.8 Save the edits and stop editing when done. 

~\ProjectName_YYYYMMDD\ProjectName_YYYYMMDD.gdb 

~\NevadaDataPackage_v1_3 
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Figure 8: Example completed map unit attribute table 

Tips 
 Before beginning to delineate map units, we recommend referencing the DRG layer and 

grouping the ecological sites into the identified DRG groups that are listed in the attribute table. 
Use supplemental data sources identified in the Data Required section for assistance in meadow 
delineation and other unique features. 

 Useful information about stratification has been developed by the US Department of Agriculture 
(Herrick et al., 2009, Monitoring Manual for Grassland, Shrubland and Savanna Ecosystems, 
Chapter 2 – “Stratify Land into Monitoring Units”, page 131). 

 Map units should always be confirmed in the field. 

 Ensure snapping is enabled (add the Snapping Toolbar if necessary). Also ensure ‘Snap to 
Sketch’ is enabled once in your editing session, this will allow you to create map units that are 
fully contained within one other map unit. 

 Meadows should be digitized as distinct map units. Meadows are important resources for sage-
grouse and so take care in identifying and delineating all meadows within the project area.  

D6. Run Debit Tool 3 
[ArcToolbox > DebitTools > Debit Tool 3] 
 Project Geodatabase = the default project geodatabase for this project 
 Nevada Data Package = the parent folder of the Nevada Data Package, named 

NevadaDataPackage_v1_3. 
 Project Folder = the unique folder for this project that contains the default project 

geodatabase and the map document. 
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Figure 9: Debit Tool 3 interface 

D7.  Identify and delineate anthropogenic features 
Each ‘Anthro_*feature type*_Clip’ layer is provided as a starting point to help identify and delineate 
anthropogenic features that exist on the landscape. A combination of these layers, aerial imagery, and 
knowledge of the site should be used to identify existing anthropogenic features within the extent of 
the Analysis_Area_6000m layer.   

For each anthropogenic feature layer in the Table of Contents of the map document: 

D7.1 Right click on the layer in the Table of Contents, click ‘Edit Features’, then click ‘Start 
Editing’. Using editing tools, modify and/or delineate features as needed. 

D7.2 Open the attribute table and populate the ‘Type’ and ‘Subtype’ fields for each entry. Use the 
Type Code and Subtype Code for each attribute as provided in Table 1. Be sure to save edits 
and stop editing when done. 

Tips 
 Do not change the names of the ‘Anthro_*feature type*_Clip’ layers. If existing anthropogenic 

features of a specific type are digitized in a layer other than the ‘Anthro_*feature type*_Clip’ 
layer created in step D7, copy and paste those features into the appropriate  ‘Anthro_*feature 
type*_Clip’ layer.  

▫ Click the Edit tool (          ) on the Editor toolbar 

▫ Click the feature you want to copy. Hold down SHIFT while clicking features to select 
additional features. 

▫ Click the Copy button (            ) on the Standard toolbar. 

▫ Click the Paste button (           ) on the Standard toolbar. 

▫ Click the ‘Anthro_*feature type*_Clip’ layer in which to store the pasted feature. 

▫ Click OK. The feature is pasted into the appropriate layer. 

 Do not digitize pipeline rights-of-way as roads, unless the right-of-way contains a road that 
meets the definitions in Table 1. Pipeline rights-of-way are a series of connected straight lines. 
Roads are mostly not perfectly straight lines. Anthropogenic features not described in Table 1 
are considered ‘de minimus’ and should not be digitized. 

~\ProjectName_YYYYMMDD\ProjectName_YYYYMMDD.gdb 
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 For mining or renewable energy facilities, proposed infrastructure such as roads and powerlines 
that are located within or immediately adjacent to anthropogenic features should be categorized 
as mining or renewable energy features. Proposed roads or powerlines that fall outside of the 
project footprint, such as those connecting the project to existing infrastructure, should be 
categorized as roads and powerlines. 

 Use the Data Driven Pages feature in ArcGIS to check your work before moving on:  

 Create a grid index to facilitate review of aerial imagery at approximately 1:5,000 scale.  

[ArcToolbox> Cartography Tools> Data Driven Pages> Grid Index Features] 
 Output Feature Class = a new layer named GridIndexFeatures 
 Input Features = Analysis_Area_6000m 
 Generate Polygon Grid that intersects input feature layers or datasets = checked 
 Use Page Unit and Scale = unchecked 
 Polygon Width = 1000 (in meters) 
 Polygon Height = 1000 (in meters) 
 All other fields = blank 

 Add the Data Driven Pages toolbar (Customize >Toolbars >Data Driven Pages), then 
set up data driven pages by clicking the Data Driven Page Setup icon (        ) and 
selecting GridIndexFeatures as the Layer. Leave all other options unchanged and click 
‘OK’. 

 Flip through every page using the next page icon (      ) for a thorough review. 

D8.  Acquire the Dist_Lek layer from the Nevada Department of Wildlife (NDOW) 

D8.1 Submit a Data Request Form, available from the NDOW website at 
http://www.ndow.org/Nevada_Wildlife/Maps_and_Data/Data/.  

D8.2 Provide the Assessment_Area_6000m layer as the ‘Project Extent’. The 
Assessment_Area_6000m layer is saved as a shapefile in the project folder. Clarify that you 
are requesting the Dist_Lek layer for the purpose of assessing a project site for the 
Conservation Credit System. 

D9.  Run Debit Tool 4 
[ArcToolbox > DebitTools > Debit Tool 4] 
 Project Geodatabase = the default project geodatabase for this project. 
 Nevada Data Package = the parent folder of the Nevada Data Package, named 

NevadaDataPackage_v1_3. 
 Map Units = the feature class or shapefile containing the delineated map units, most often 

the Map_Units layer.  
 Dist_Lek = represents the habitat quality associated with the distance to leks within the 

Analysis Area. Layer must be provided by NDOW. See step D8. 
 Current_Anthro_Features (optional) = if existing anthropogenic features were not 

delineated within each ‘Anthro_*feature type*_Clip’ layer in step D7, provide the feature 
class or shapefile in which anthropogenic features were delineated. Ensure that the 
provided layer has a ‘Type’ and ‘Subtype’ field in the attribute table, and that the Type and 
Subtype are categorized according to the Type Code and Subtype Code provided in Table 1 
(optional). 

http://www.ndow.org/Nevada_Wildlife/Maps_and_Data/Data/
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Figure 10: Debit Tool 4 interface 

Tips 
 The Dist_Lek layer should be scaled from ≥0 to ≤1 and have the same extent as the 

Analysis_Area_6000m layer. Ensure that this is the case. 

 If a feature class named Map_Units_Dissolve already exists in the project geodatabase (which 
may be the case if you did not follow these steps but delineated map units through a separate 
process), that feature class will be overwritten by Debit Tool 4. You may either change that 
layer’s name (we recommend Map_Units_Copy) or save a copy outside of the project 
geodatabase if overwriting that layer is not desired. 

 If a feature class named Current_Anthro_Features already exists in the project geodatabase 
(which may be the case if you did not follow these steps but delineated anthropogenic features 
through a separate process), that feature class will be used by Debit Tool 4, regardless of the 
feature class or shapefile provided to the tool as the parameter ‘Current_Anthro_Features’. If 
you do not wish to use that layer in Debit Tool 4, remove it from the project geodatabase before 
running Debit Tool 4. 

D10.  Specify number of transects for each map unit 

D10.1 Open the attribute table of the Map_Units_Dissolve layer. 

D10.2 Populate the ‘Transects’ field for each map unit with the number of transects to be sampled 
within each map unit according to the necessary sampling intensity (see Appendix 2. 
Recommended Transects per Map Unit). For the map unit associated with existing surface 
disturbance, and any other map units where field data will not be collected, input ‘0’. See 
Appendix 2. Recommended Transects Per Map Unit for help determining number of 
transects required. 

D10.3 Save edits and stop editing when done. 

~\NevadaDataPackave_v1_3 
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~\ProjectName_YYYYMMDD\ProjectName_YYYYMMDD.gdb 

Dist_Lek 



 
 
NEVADA CONSERVATION CREDIT SYSTEM USER’S GUIDE PAGE 24 

 

CONSERVATION CREDIT SYSTEM USER’S GUIDE  
V1.3_AUTOMATED 

 

Tips 
 A number of transects should only be specified for map units that will be sampled in the field. 

For map units where field data will not be collected, input ‘0’ in the ‘Transects’ field. 

 Ensure that the total number of transects generated is equal to the number of transects desired. 

 If the first random bearing generated for a transect results in a transect that cannot be sampled 
by field crews, the next random bearing in the Transects attribute table should be used. See Field 
Data Collections Methods for more information. Two additional random bearings are generated 
for each transects. 

D11.  Run Debit Tool 5 
[ArcToolbox > DebitTools > DebitTool_5] 
 Project Geodatabase = the default project geodatabase for this project 

 
Figure 11: Debit Tool 5 interface 

D12.  Run Debit Tool 6 
 [ArcToolbox > DebitTools > DebitTool_6] 
 Project Geodatabase = the default project geodatabase for this project 
 Nevada Data Package = the parent folder of the Nevada Data Package, named 

NevadaDataPackage_v1_3. 
 Project Folder = the unique folder for this project that contains the default project 

geodatabase and the map document. 
 Project Name (optional) = provide a unique name for the project to append to the exported 

data tables (optional).  

~\ProjectName_YYYYMMDD\ProjectName_YYYYMMDD.gdb 
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Figure 12: Debit Tool 6 interface 

Tips 
 For small (< 0.5 acre) or narrow meadow map units for which local scale habitat functions are 

not calculated, complete the following steps.   

 In the Map_Units_Dissolve layer, select the Meadow map unit(s) that did not calculate a 
local scale habitat function or are smaller than 0.5 acres. 

 Using the Buffer tool, buffer the Map_Units_Dissolve layer by 20m (Note: You may need to 
buffer by a greater distance, however we want to use the smallest buffer possible). Name 
this layer Map_Units_Meadows. 

 [ArcToolbox> Analysis Tools> Proximity> Buffer] 
 Input Features = Map_Units_Dissolve, 
 Output Feature Class = Map_Units_Meadows, 
 Distance = 20 (in meters), 
 Side Type = FULL,  
 Method = PLANAR,  
 Dissolve Type = ALL, 
 Dissolve Fields = none checked. 

▫ Using the Zonal Statistics as Table tool, average all pixels of the Current_Local_Breed 
within each meadow map unit. Name the output tables as in 
ZonalSt_Current_Breed_Meadows.  

[ArcToolbox> Spatial Analyst Tools> Zonal> Zonal Statistics as Table] 
 Input raster or feature zone data = Map_Units_Meadows layer 
 Zone Field = ‘Map_Units_ID’ 
 Input value raster = Current_Local_Breed 
 Output table = ZonalSt_Current_Breed_Meadows 
 Ignore NoData in calculations = checked 
 Statistics type = MEAN 

▫ Repeat the previous steps for all local scale modifiers.  

~\ProjectName_YYYYMMDD\ProjectName_YYYYMMDD.gdb 

~\NevadaDataPackage_v1_3 
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▫ Using the Join Field tool, join the MEAN field for the ZonalSt_Current_Breed_Meadows 
table to the Map_Units_Meadows layer 

 [ArcToolbox> Data Management Tools> Joins> Join Field] 
 Input Table = Map_Units_Meadows layer 
 Input Join Field = Map_Unit_ID 
 Join Table = ZonalSt_Current_Breed_Meadows 
 Output Join Field = Map_Unit_ID 
 Join Field = check ‘MEAN’. 

▫ Repeat the previous step for all zonal statistics tables calculated.  
▫ Export the attribute table of the Map_Units_Meadows layer to a text file named 

‘Map_Unit_Meadows_Data’: 
 Open the attribute table of the Map_Units_Meadows layer. 

 Under ‘Table Options’ (  ) select Export and save as a .txt file. Name this file 
Map_Units_Meadows_Data. 

 When prompted to add the table to the current map, select ‘No’. 
▫ Add the Export Table to the blank workbook: 

 In the Data Ribbon, ‘Get External Data’ section, select ‘From Text’. 
 Navigate to the Export Table and Open the Export Table. When opening, specify the 

file is comma-delimited. 
 Copy the relevant columns from the Export Table into the corresponding worksheets 

and columns in the Project Calculator. See Figure 13 for a list of Export Tables 
generated during the Desktop Analysis that must be inputted into the Calculator. 

 Add the local scale modifier data for the meadow map units to the corresponding map 
unit IDs in the Map_Units_Data excel file prior to entering the data into the HQT 
calculator. 

D13.  Add the exported data to the Debit Project Calculator  

D13.1 Open the Map_Unit_Data.xls, Transects_Data.xls and Mgmt_Cat_Data.xls files in Excel. 

D13.2 Copy the relevant columns from the tables into the corresponding worksheets and columns 
in the Project calculator. See Figure 13 for a list of data generated during the Desktop 
Analysis that must be inputted into the Project HQT Calculator. 

 EXPORT TABLE CALCULATOR WORKSHEET 

□ Transects_Data 1.2 Enter Transects Data 

□ Mgmt_Cats_Data 1.3 Enter Mgmt Cats Data 

□ Map_Units_Data 1.1 Enter Map Unit Data 
 

Figure 13: Export Tables generated and corresponding Calculator worksheet 

Tips 
 The Calculator includes more detailed instructions for how to input data from each field 

datasheet. See rows 1 and 2 in the relevant worksheet in the Calculator. 

 After completing Debit Tool 6, you are now ready to complete Section 2. Field Data Collection 
Method. The field crew will confirm the boundaries of map units, add or remove transect 
locations, and confirm the location of anthropogenic features. When field work is complete, 
make any necessary revisions to the Map_Units_Dissolve layer, Transects layer, and 
Current_Anthro_Features layer. 
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 If the field crews recommend changes to the Map_Units_Dissolve layer, Transects layer, and 
Current_Anthro_Features layer, make necessary revisions and redo steps D9 (Debit Tool 4) and 
D12 (Debit Tool 6). Specify the updated Map_Units_Dissolve layer for the Map_Units 
parameter and updated Current_Anthro_Features layer for the Current_Anthro_Features 
parameter in Debit Tool 4. Modify the Transects layer as necessary before running Debit Tool 6.
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CREDIT PROJECTS THAT DO NOT PROPOSE TO MODIFY CURRENT ANTHROPOGENIC 
FEATURES: GUIDANCE FOR COMPLETING THE DESKTOP ANALYSIS 

This section describes the process required to assess most credit projects. Credit projects that propose to 
modify current anthropogenic features should consult the following section, Credit Projects that Propose to 
Modify Current Anthropogenic Features: Guidance for Completing the Desktop Analysis. Tools provided in the 
Credit Toolbox are intended to facilitate the assessment of credit projects. User input is required. Please 
read each step carefully. User tips are provided for each step, some of which may be required to 
successfully complete the step in certain circumstances. We recommend reviewing this guide in its 
entirety before starting. 

Each tool will add one or more layers to the default file geodatabase. Subsequent tools require these 
layers in order to run. Do not modify or rename these layers. Only outputs that are added to the Table of 
Contents and map display should be edited. 

If you have already delineated map units and anthropogenic features, you will be able to use those layers 
in this process. You do not need to recreate those layers. If you have already delineated map units, skip 
step C3. If you have already digitized current anthropogenic features, skip step C5. However, ensure 
those layers were created in accordance with the guidance in those steps. In step C7, identify the location 
of the map units and/or current anthropogenic features layers when running Credit Tool 3 according to 
the instructions in that step. It is important that a layer named “Current_Anthro_Features” does not 
already exist in the default geodatabase for the project; this layer should be located in a separate 
geodatabase. 

For a quick reference guide to the tools and inputs required to complete the Desktop Analysis for credit 
projects, refer to Appendix 4. Quick Reference Guide: Credit Projects That Do Not Propose to Modify 
Existing Anthropogenic Features. 

C1.  Create project folder, project geodatabase, and map document 

C1.1 In ArcCatalog, create a new folder for the project. Name this folder following the convention 
ProjectName_YYYYMMDD. 

C1.2 Within the folder, create a new File Geodatabase (.gdb) by right-clicking on the folder and 
selecting ‘New’ > ‘File Geodatabase’. Give it the same name as the project folder. 

C1.3 Open NV_CCS_Map_Template (.mxd), located in the Nevada Data Package, and save a 
copy of the map document within the project folder. Give it the same name as the project 
folder. 

C1.4 If necessary, add the relevant toolbox to ArcToolbox by right-clicking on the parent 
ArcToolbox  (         ) in the ArcToolbox window and selecting ‘Add Toolbox’. Navigate to the 
Toolbox and click ‘Open’. The toolbox should now be available in the list of toolboxes. When 
working from The Nevada CCS Map Template, all toolboxes should already be available. 

C1.5 In ArcMap, open the Catalog window ( ), navigate to the new geodatabase, right click on 
it and select ‘Make Default Database’.  

  
Figure 14: Structure of the project folder 
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You will submit this Project Folder as a zipped folder (.zip) to the Credit System 
Administrator along with the Project Calculator. 

Tips 
 When creating folder names and file names, use only letters, numbers, and underscores. Do not 

use other characters. Do not start file names with a number. Some tools will not run properly if 
there are periods, hyphens, or other symbols in the folder or file names. 

C2.  Run Credit Tool 1 
[ArcToolbox > CreditTools > Credit Tool 1] 
 Project Geodatabase = the default project geodatabase for this project. 
 Credit_Project_Area = the area that is being proposed as the credit project, provided by the 

project proponent. If no shapefile was provided, see step 4 in the Data Required section to 
create this layer. 

 Nevada Data Package = the parent folder of the Nevada Data Package, named 
NevadaDataPackage_v1_3 

 
Figure 15: Credit Tool 1 interface 

Tips 
 If the Credit_Project_Boundary provided by the project proponent is represented by multiple 

shapefiles, use the Merge tool to merge the shapefiles into a single feature class.  

[ArcToolbox> Data Management> General> Merge]  
 Input Datasets = All shapefiles representing the Credit_Project_Boundary, 
 Output Dataset = append ‘_Merged’ to feature class name, 
 Field Map = leave as default. 

 Overlapping polygons must be removed from the Credit_Project_Boundary layer provided by 
the project proponent before running Credit Tool 1. Use the Intersect tool to determine if the 
layer contains overlapping polygons.  

[ArcTools> Analysis> Overlay> Intersect]  
 Input Features = Credit_Project_Boundary  
 Output Feature Class = append ‘_Merged’ to feature class name 
 Join Attributes = ALL,  
 XY Tolerance = blank,  

~\Credit_Project_Boundary 

~\NevadaDataPackage_v1_3 

~\ProjectName_YYYYMMDD\ProjectName_YYYYMMDD.gdb 
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 Output Type = INPUT.  
 If overlapping polygons are present, remove any areas of overlap: In an editing session, 

select an overlapping polygon. Select the Clip tool in the Editor toolbar (Editor> Clip). A 
dialog box will pop up. Leave the Buffer Distance = 0.0 and select ‘Discard the area that 
intersects’, then click OK. Any polygon portions overlapping the selected polygons will be 
deleted. Repeat for all overlapping polygons.  Consult the project proponent if unsure 
about how to categorize overlapping areas. 

C3.  Divide Map_Units layer into discrete map units & populate attribute table 

C3.1 Open the attribute table of the Map_Units layer.  

C3.2 Start an editing session by right-clicking on the layer in the Table of Contents, clicking ‘Edit 
Features’, then ‘Start Editing’. 

C3.3 Using the Cut Polygon tool (  ) in the Editor Toolbar, delineate map units in the 
Map_Units layer. See Appendix 1. Guidance for Delineating Map Units  for detailed 
information. 

C3.4 Name map units numerically and record the name in the ‘Map_Unit_ID’ field. Map units 
that appear to be very similar, but not adjacent to each other, can receive the same numerical 
name and be considered a single map unit. In the field, a visual walk-through should 
confirm this is the case. 

C3.5 Name each map unit by providing a short description, typically associated with the major 
vegetation type, in the ‘Map_Unit_Name’ field. 

C3.6 For any map units that are meadows, populate the ‘Meadow’ attribute with ‘Altered’ or 
‘Unaltered’. For all other map units, populate the ‘Meadow’ attribute with ‘No Meadow’. 
Meadow type definitions are provided in the ‘Tips’ below.  

C3.7 Populate the ‘Precip’ field for each map unit with the correct precipitation regime from the 
Precip layer. Record if the map unit falls in the ‘Arid’ or ‘Mesic’ precipitation regime. If a 
map unit spans both precipitation regimes, record the dominant regime or split the map unit 
into two map units.  

C3.8 Save the edits and stop editing when done. 

 
Figure 16: Example completed Map_Unit attribute table 
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Tips 
 Before beginning to delineate map units, we recommend referencing the DRG layer and 

grouping the ecological sites into the identified DRG groups that are listed in the attribute table. 
Use supplemental data sources identified in the Data Required section for assistance in meadow 
delineation and other unique features. 

 Useful information about stratification has been developed by the US Department of Agriculture 
(Herrick, et al., 2009, Monitoring Manual for Grassland, Shrubland and Savanna Ecosystems, 
Chapter 2 – “Stratify Land into Monitoring Units”, page 131). 

 Map units should always be confirmed in the field. 

 Ensure snapping is enabled (add the Snapping Toolbar if necessary). Also ensure ‘Snap to 
Sketch’ is enabled once in your editing session, this will allow you to create map units that are 
fully contained within one other map unit. 

 Meadows should be digitized as distinct map units. Meadows are important resources for sage-
grouse and so take care in identifying and delineating all meadows within the project area. 

▫ Unaltered meadows are defined at naturally occurring wetland complexes, dominated by 
wetland vegetation and soils (e.g. stringer meadows, springs, seeps) where the hydrology 
has been minimally altered or is currently not being managed. 

▫ Altered meadows are defined as receiving either controlled irrigation, where the hydrology 
is currently being altered or managed (e.g. diversions, spreaders), or where the landscape is 
being functionally altered. 

C4.  Run Credit Tool 2 
[ArcToolbox > CreditTools > Credit Tool 2] 
 Project Geodatabase = the default project geodatabase for this project. 
 Nevada Data Package = the parent folder of the Nevada Data Package, named 

NevadaDataPackage_v1_3 
 Project Folder = the unique folder for this project that contains the default project 

geodatabase and the map document. 

 
Figure 17: Credit Tool 2 interface 

~\NevadaDataPackage_v1_3 

~\ ProjectName_YYYYMMDD 
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C5.  Identify and delineate anthropogenic features 
Each ‘Anthro_*feature type*_Clip’ layer is provided as a starting point to help identify and delineate 
anthropogenic features that exist on the landscape. A combination of these layers, aerial imagery, and 
knowledge of the site should be used to identify existing anthropogenic features within the extent of 
the Analysis_Area_6000m layer.   

For each anthropogenic feature layer in the Table of Contents of the map document: 

C5.1 Right click on the layer in the Table of Contents, click ‘Edit Features’, then click ‘Start 
Editing’. Using editing tools, modify and/or delineate features as needed. 

C5.2 Open the attribute table and populate the ‘Type’ and ‘Subtype’ fields for each entry. Use the 
Type Code and Subtype Code for each attribute as provided in Table 1. Be sure to save edits 
and stop editing when done. 

Tips 
 Do not change the names of the ‘Anthro_*feature type*_Clip’ layers. If existing anthropogenic 

features of a specific type are digitized in a layer other than the ‘Anthro_*feature type*_Clip’ 
layer created in step D7, copy and paste those features into the appropriate ‘Anthro_*feature 
type*_Clip’ layer.  

▫ Click the Edit tool (          ) on the Editor toolbar 

▫ Click the feature you want to copy. Hold down SHIFT while clicking features to select 
additional features. 

▫ Click the Copy button (            ) on the Standard toolbar. 

▫ Click the Paste button (           ) on the Standard toolbar. 

▫ Click the ‘Anthro_*feature type*_Clip’ layer in which to store the pasted feature. 

▫ Click OK. The feature is pasted into the appropriate layer. 

 Do not digitize pipeline rights-of-way as roads, unless the right-of-way contains a road that 
meets the definitions in Table 1. Pipeline rights-of-way are a series of connected straight lines. 
Roads are mostly not perfectly straight lines. Anthropogenic features not described in Table 1 
are considered ‘de minimus’ and should not be digitized. 

 For mining or renewable energy facilities, proposed infrastructure such as roads and powerlines 
that are located within or immediately adjacent to anthropogenic features should be categorized 
as mining or renewable energy features. Proposed roads or powerlines that fall outside of the 
project footprint, such as those connecting the project to existing infrastructure, should be 
categorized as roads and powerlines. 

 Use the Data Driven Pages feature in ArcGIS to check your work before moving on:  

 Create a grid index to facilitate review of aerial imagery at approximately 1:5,000 scale.  

[ArcToolbox> Cartography Tools> Data Driven Pages> Grid Index Features] 
 Output Feature Class = a new layer named GridIndexFeatures 
 Input Features = Analysis_Area_6000m 
 Generate Polygon Grid that intersects input feature layers or datasets = checked 
 Use Page Unit and Scale = unchecked 
 Polygon Width = 1000 (in meters) 
 Polygon Height = 1000 (in meters) 
 All other fields = blank 



 
 
NEVADA CONSERVATION CREDIT SYSTEM USER’S GUIDE PAGE 33 

 

CONSERVATION CREDIT SYSTEM USER’S GUIDE  
V1.3_AUTOMATED 

 

 Add the Data Driven Pages toolbar (Customize >Toolbars >Data Driven Pages), then 
set up data driven pages by clicking the Data Driven Page Setup icon (        ) and 
selecting GridIndexFeatures as the Layer. Leave all other options unchanged and click 
‘OK’. 

 Flip through every page using the next page icon (      ) for a thorough review. 

C6.  Acquire the Dist_Lek layer from the Nevada Department of Wildlife (NDOW) 

C6.1 Submit a Data Request Form, available from the NDOW website at 
http://www.ndow.org/Nevada_Wildlife/Maps_and_Data/Data/.  

C6.2 Provide the Assessment_Area_6000m layer as the ‘Project Extent’. The 
Assessment_Area_6000m layer is saved as a shapefile in the project folder. Clarify that you 
are requesting the Dist_Lek layer for the purpose of assessing a project site for the 
Conservation Credit System. 

C7.  Run Credit Tool 3 
[ArcToolbox > CreditTools > Credit Tool 3] 
 Project Geodatabase = the default project geodatabase for this project. 
 Nevada Data Package = the parent folder of the Nevada Data Package, named 

NevadaDataPackage_v1_3 
 Map_Units = the feature class or shapefile containing the delineated map units, most often 

the Map_Units layer. 
 Dist_Lek = represents the habitat quality associated with the distance to leks within the 

Analysis Area. Layer must be provided by NDOW. See step C6. 

 
Figure 18: Credit Tool 3 interface 

Tips 
 The Dist_Lek layer should be scaled from ≥0 to ≤1 and have the same extent as the 

Analysis_Area_6000m layer. Ensure that this is the case. 

~\NevadaDataPackage_v1_3 

Map_Units 

~\ProjectName_YYYYMMDD\ProjectName_YYYYMMDD.gdb 

Dist_Lek 
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 If a feature class named Map_Units_Dissolve already exists in the project geodatabase (which 
may be the case if you did not follow these steps but delineated map units through a separate 
process), that feature class will be overwritten by Credit Tool 3. You may either change that 
layer’s name (we recommend Map_Units_Copy) or save a copy outside of the project 
geodatabase if overwriting that layer is not desired. 

 If a feature class named Current_Anthro_Features already exists in the project geodatabase 
(which may be the case if you did not follow these steps but delineated anthropogenic features 
through a separate process), that feature class will be used by Credit Tool 3, regardless of the 
feature class or shapefile provided to the tool as the parameter ‘Current_Anthro_Features’. If 
you do not wish to use that layer in Credit Tool 3, remove it from the project geodatabase before 
running Credit Tool 3. 

C8. Specify number of transects for each map unit 

C8.1 Open the attribute table of the Map_Units_Dissolve layer. 

C8.2 Populate the ‘Transects’ field for each map unit with the number of transects to be sampled 
within each map unit according to the necessary sampling intensity (see Appendix 2. 
Recommended Transects per Map Unit). For the map unit associated with existing surface 
disturbance, and any other map units where field data will not be collected, input ‘0’. See 
Appendix 2. Recommended Transects Per Map Unit for help determining number of 
transects required. 

C8.3 Save edits and stop editing when done. 

Tips 
 A number of transects should only be specified for map units that will be sampled in the field. 

For map units where field data will not be collected, input ‘0’ in the ‘Transects’ field. 

 Ensure that the total number of transects generated is equal to the number of transects desired. 

 If the first random bearing generated for a transect results in a transect that cannot be sampled 
by field crews, the next random bearing in the Transects attribute table should be used. See Field 
Data Collections Methods for more information. Two additional random bearings are generated 
for each transects. 

C9.  Run Credit Tool 4 
[ArcToolbox > CreditTools > Credit Tool 4] 
 Project Geodatabase = the default project geodatabase for this project. 

 
Figure 19: Credit Tool 4 interface 

~\ProjectName_YYYYMMDD\ProjectName_YYYYMMDD.gdb 
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C10.  Run Credit Tool 5 
[ArcToolbox > CreditTools > Credit Tool 5] 
 Project Geodatabase = the default project geodatabase for this project. 
 Nevada Data Package = the parent folder of the Nevada Data Package, named 

NevadaDataPackage_v1_3 
 Project_Folder = the unique folder for this project that contains the default project 

geodatabase and the map document. 

 

Figure 20: Credit Tool 5 interface 

Tips 
 For small (< 0.5 acre) or narrow meadow map units for which local scale habitat functions are 

not calculated, complete the following steps.   

 In the Map_Units_Dissolve layer, select the Meadow map unit(s) that did not calculate a 
local scale habitat function or are smaller than 0.5 acres. 

 Using the Buffer tool, buffer the Map_Units_Dissolve layer by 20m (Note: You may need to 
buffer by a greater distance, however we want to use the smallest buffer possible). Name 
this layer Map_Units_Meadows. 

 [ArcToolbox> Analysis Tools> Proximity> Buffer] 
 Input Features = Map_Units_Dissolve, 
 Output Feature Class = Map_Units_Meadows, 
 Distance = 20 (in meters), 
 Side Type = FULL,  
 Method = PLANAR,  
 Dissolve Type = ALL, 
 Dissolve Fields = none checked. 

▫ Using the Zonal Statistics as Table tool, average all pixels of the Current_Local_Breed 
within each meadow map unit. Name the output tables as in 
ZonalSt_Current_Breed_Meadows.  

~\ProjectName_YYYYMMDD\ProjectName_YYYYMMDD.gdb 

~\NevadaDataPackage_v1_3 

~\ProjectName_YYYYMMDD 
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[ArcToolbox> Spatial Analyst Tools> Zonal> Zonal Statistics as Table] 
 Input raster or feature zone data = Map_Units_Meadows layer 
 Zone Field = ‘Map_Units_ID’ 
 Input value raster = Current_Local_Breed 
 Output table = ZonalSt_Current_Breed_Meadows 
 Ignore NoData in calculations = checked 
 Statistics type = MEAN 

▫ Repeat the previous steps for all local scale modifiers.  
▫ Using the Join Field tool, join the MEAN field for the ZonalSt_Current_Breed_Meadows 

table to the Map_Units_Meadows layer 

 [ArcToolbox> Data Management Tools> Joins> Join Field] 
 Input Table = Map_Units_Meadows layer 
 Input Join Field = Map_Unit_ID 
 Join Table = ZonalSt_Current_Breed_Meadows 
 Output Join Field = Map_Unit_ID 
 Join Field = check ‘MEAN’. 

▫ Repeat the previous step for all zonal statistics tables calculated.  
▫ Export the attribute table of the Map_Units_Meadows layer to a text file named 

‘Map_Unit_Meadows_Data’: 
 Open the attribute table of the Map_Units_Meadows layer. 

 Under ‘Table Options’ (  ) select Export and save as a .txt file. Name this file 
Map_Units_Meadows_Data. 

 When prompted to add the table to the current map, select ‘No’. 
▫ Add the Export Table to the blank workbook: 

 In the Data Ribbon, ‘Get External Data’ section, select ‘From Text’. 
 Navigate to the Export Table and Open the Export Table. When opening, specify the 

file is comma-delimited. 
 Copy the relevant columns from the Export Table into the corresponding worksheets 

and columns in the Project Calculator. See Figure 21 for a list of Export Tables 
generated during the Desktop Analysis that must be inputted into the Calculator. 

 Add the local scale modifier data for the meadow map units to the corresponding map 
unit IDs in the Map_Units_Data excel file prior to entering the data into the HQT 
calculator. 

C11.  Add the exported data to the Credit Project Calculator  

C11.1 Open the Map_Unit_Data.xls, Transects_Data.xls and Mgmt_Cat_Data.xls files in Excel. 

C11.2 Copy the relevant columns from the tables into the corresponding worksheets and columns 
in the Project calculator. See Figure 24 for a list of data generated during the Desktop 
Analysis that must be inputted into the Project HQT Calculator. 

 EXPORT TABLE CALCULATOR WORKSHEET 

□ Transects_Data 1.2 Enter Transects Data 

□ Mgmt_Cats_Data 1.3 Enter Mgmt Cats Data 

□ Map_Units_Data 1.1 Enter Map Unit Data 
 

Figure 21: Export Tables generated and corresponding Calculator worksheet 
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Tips 
 The Calculator includes more detailed instructions for how to input data from each field 

datasheet. See rows 1 and 2 in the relevant worksheet in the Calculator. 

 After completing Credit Tool 5, you are now ready to complete Section 2. Field Data Collection 
Method. The field crew will confirm the boundaries of map units, add or remove transect 
locations, and confirm the location of anthropogenic features. When field work is complete, 
make any necessary revisions to the Map_Units_Dissolve layer, Transects layer, and 
Current_Anthro_Features layer. 

 If the field crews recommend changes to the Map_Units_Dissolve layer, Transects layer, and 
Current_Anthro_Features layer, you must redo steps C7 (Credit Tool 3), C9 (Credit Tool 4) and 
C10 (Credit Tool 5). Specify the updated Map_Units_Dissolve layer for the Map_Units 
parameter and updated Current_Anthro_Features layer for the Current_Anthro_Features 
parameter in Credit Tool 3. Modify the Transects layer as necessary before running Credit Tool 
4. 
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CREDIT PROJECTS THAT PROPOSE TO MODIFY CURRENT ANTHROPOGENIC FEATURES: 
GUIDANCE FOR COMPLETING THE DESKTOP ANALYSIS 

This section describes the process required to assess a credit project that proposes to modify current 
anthropogenic features. Tools provided in the Credit Toolbox Reclaim are intended to facilitate the 
assessment of this type of credit project. User input is required. Please read each step carefully. User tips 
are provided for each step, some of which may be required to successfully complete the step in certain 
circumstances. We recommend reviewing this guide in its entirety before starting. 

Each tool will add one or more layers to the default file geodatabase. Subsequent tools require these 
layers in order to run. Do not modify or rename these layers. Only outputs that are added to the Table of 
Contents and map display should be edited. 

If you have already delineated map units and anthropogenic features, you will be able to use those layers 
in this process. You do not need to recreate those layers. If you have already delineated map units, skip 
step CR5. If you have already digitized current anthropogenic features, skip step CR7. However, ensure 
those layers were created in accordance with the guidance in those steps. In step CR9, identify the 
location of the map units and/or current anthropogenic features layers when running Credit Tool Reclaim 
4 according to the instructions in that step. It is important that a layer named “Current_Anthro_Features” 
does not already exist in the default geodatabase for the project; this layer should be located in a separate 
geodatabase. 

For a quick reference guide to the tools and inputs required to complete the Desktop Analysis for credit 
reclaim projects, refer to Appendix 5. Quick Reference Guide: Credit Projects That Propose to Modify 
Existing Anthropogenic Features. 

CR1.  Create project folder, project geodatabase, and map document 

CR1.1 In ArcCatalog, create a new folder for the project. Name this folder following the convention 
ProjectName_YYYYMMDD. 

CR1.2 Within the folder, create a new File Geodatabase (.gdb) by right-clicking on the folder and 
selecting ‘New’ > ‘File Geodatabase’. Give it the same name as the project folder. 

CR1.3 Open NV_CCS_Map_Template (.mxd), located in the Nevada Data Package, and save a 
copy of the map document within the project folder. Give it the same name as the project 
folder. 

CR1.4 If necessary, add the relevant toolbox to ArcToolbox by right-clicking on the parent 
ArcToolbox  (         ) in the ArcToolbox window and selecting ‘Add Toolbox’. Navigate to the 
Toolbox and click ‘Open’. The toolbox should now be available in the list of toolboxes. When 
working from The Nevada CCS Map Template, all toolboxes should already be available. 

CR1.5 In ArcMap, open the Catalog window ( ), navigate to the new geodatabase, right click on 
it and select ‘Make Default Database’.  

  
Figure 22: Structure of the project folder 
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You will submit this Project Folder as a zipped folder (.zip) to the Credit System 
Administrator along with the Project Calculator. 

Tips 
 When creating folder names and file names, use only letters, numbers, and underscores. Do not 

use other characters. Do not start file names with a number. Some tools will not run properly if 
there are periods, hyphens, or other symbols in the folder or file names. 

CR2.  Run Credit Tool Reclaim 1 
[ArcToolbox > CreditToolbox_Reclaim> Credit Tool Reclaim 1] 
 Project Geodatabase = the default project geodatabase for this project. 
 Credit_Project_Area = the area that is being proposed as the credit project, provided by the 

project proponent. If no shapefile was provided, see step 4 in the Data Required section to 
create this layer. 

 Nevada Data Package = the parent folder of the Nevada Data Package, named 
NevadaDataPackage_v1_3 

 Anthropogenic features to be reclaimed (if provided) (optional) = the area of current 
anthropogenic features proposed for modification. This input is optional.  

 
Figure 23: Credit Tool Reclaim 1 interface 

Tips 
 If the Credit_Project_Boundary provided by the project proponent is represented by multiple 

shapefiles, use the Merge tool to merge the shapefiles into a single feature class.  

[ArcToolbox> Data Management> General> Merge]  
 Input Datasets = All shapefiles representing the Credit_Project_Boundary, 
 Output Dataset = Credit_Project_Boundary, 
 Field Map = leave as default. 

 Overlapping polygons must be removed from the Credit_Project_Boundary layer provided by 
the project proponent before running Credit Tool 1. Use the Intersect tool to determine if the 
layer contains overlapping polygons.  

[ArcTools> Analysis> Overlay> Intersect]  
 Input Features = Credit_Project_Boundary  

~\Credit_Project_Boundary 

~\NevadaDataPackage_v1_3 

~\ProjectName_YYYYMMDD\ProjectName_YYYYMMDD.gdb 
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 Output Feature Class = append ‘_Merged’ to feature class name 
 Join Attributes = ALL,  
 XY Tolerance = blank,  
 Output Type = INPUT.  
 If overlapping polygons are present, remove any areas of overlap: In an editing session, 

select an overlapping polygon. Select the Clip tool in the Editor toolbar (Editor> Clip). A 
dialog box will pop up. Leave the Buffer Distance = 0.0 and select ‘Discard the area that 
intersects’, then click OK. Any polygon portions overlapping the selected polygons will be 
deleted. Repeat for all overlapping polygons.  Consult the project proponent if unsure 
about how to categorize overlapping areas. 

 If a shapefile or feature class identifying anthropogenic features to be reclaimed is not provided 
by the project proponent, you will create this layer in the following steps.  

CR3.  Identify and delineate anthropogenic features proposed for modification  

CR3.1 In the Table of Contents window, right-click on the Proposed_Modified_Features layer and 
open the attribute table. 

CR3.2 Start an editing session by right-clicking on the Proposed_Modified_Features layer in the 
Table of Contents and selecting ‘Edit Features > Start Editing’. 

CR3.3 Review any features that are already delineated, and edit as needed. Ensure that the outer 
extents of all anthropogenic features proposed for modification are digitized correctly. 
Delineate additional features as needed.  

CR3.4 Populate the ‘Type’ and ‘Subtype’ fields for each entry. Be sure to save edits and stop editing 
when done. The ‘Type’ and ‘Subtype’ provided here should reflect the current ‘Type’ and 
‘Subtype’ of the feature, not the ‘Type’ and ‘Subtype’ after modification. 

 
Figure 24: Example completed Proposed_Modified_Features attribute table 

CR4. Run Credit Tool Reclaim 2 
[ArcToolbox > CreditToolbox_Reclaim> Credit Tool Reclaim 2] 
 Project Geodatabase = the default project geodatabase for this project. 
 Nevada Data Package = the parent folder of the Nevada Data Package, named 

NevadaDataPackage_v1_3 
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Figure 25: Credit Tool Reclaim 2 interface 

CR5.  Divide Map_Units layer into discrete map units & populate attribute table 

CR5.1 Open the attribute table of the Map_Units layer. 

CR5.2 Start an editing session by right-clicking on the layer in the Table of Contents, clicking ‘Edit 
Features’, then ‘Start Editing’. 

CR5.3 Using the Cut Polygon tool (  ) in the Editor Toolbar, delineate map units in the 
Map_Units layer. See Appendix 1. Guidance for Delineating Map Units for detailed 
information. 

CR5.4 Name map units numerically and record the name in the ‘Map_Unit_ID’ field. Map units 
that appear to be very similar, but not adjacent to each other, can receive the same numerical 
name and be considered a single map unit. In the field, a visual walk-through should 
confirm this is the case. 

CR5.5 Name each map unit by providing a short description, typically associated with the major 
vegetation type, in the ‘Map_Unit_Name’ field. 

CR5.6 For any map units that are meadows, populate the ‘Meadow’ attribute with ‘Altered’ or 
‘Unaltered’. For all other map units, populate the ‘Meadow’ attribute with ‘No Meadow’. 
Meadow type definitions are provided in the ‘Tips’ below.  

CR5.7 Populate the ‘Precip’ field for each map unit with the correct precipitation regime from the 
Precip layer. Record if the map unit falls in the ‘Arid’ or ‘Mesic’ precipitation regime. If a 
map unit spans both precipitation regimes, record the dominant regime or split the map unit 
into two map units.  

CR5.8 Save the edits and stop editing when done. 

~\NevadaDataPackage_v1_3 

~\ProjectName_YYYYMMDD\ProjectName_YYYYMMDD.gdb 
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Figure 26: Example completed Map_Units attribute table 

Tips 
 Before beginning to delineate map units, we recommend referencing the DRG layer and 

grouping the ecological sites into the identified DRG groups that are listed in the attribute table. 
Use supplemental data sources identified in the Data Required section for assistance in meadow 
delineation and other unique features. 

 Useful information about stratification has been developed by the US Department of Agriculture 
(Herrick, et al., 2009, Monitoring Manual for Grassland, Shrubland and Savanna Ecosystems, 
Chapter 2 – “Stratify Land into Monitoring Units”, page 131). 

 Map units should always be confirmed in the field. 

 Ensure snapping is enabled (add the Snapping Toolbar if necessary). Also ensure ‘Snap to 
Sketch’ is enabled once in your editing session, this will allow you to create map units that are 
fully contained within one other map unit. 

 Meadows should be digitized as distinct map units. Meadows are important resources for sage-
grouse and so take care in identifying and delineating all meadows within the project area. 

▫ Unaltered meadows are defined at naturally occurring wetland complexes, dominated by 
wetland vegetation and soils (e.g. stringer meadows, springs, seeps) where the hydrology 
has been minimally altered or is currently not being managed. 

▫ Altered meadows are defined as receiving either controlled irrigation, where the hydrology 
is currently being altered or managed (e.g. diversions, spreaders), or where the landscape is 
being functionally altered. 

CR6.  Run Credit Tool Reclaim 3 
[ArcToolbox > CreditToolbox_Reclaim> Credit Tool Reclaim 3] 
 Project Geodatabase = the default project geodatabase for this project. 
 Nevada Data Package = the parent folder of the Nevada Data Package, named 

NevadaDataPackage_v1_3 
 Project_Folder = the unique folder for this project that contains the default project 

geodatabase and the map document. 
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Figure 27: Credit Tool Reclaim 3 interface 

CR7.  Identify and delineate anthropogenic features 
Each ‘Anthro_*feature type*_Clip’ layer is provided as a starting point to help identify and delineate 
anthropogenic features that exist on the landscape. A combination of these layers, aerial imagery, and 
knowledge of the site should be used to identify existing anthropogenic features within the extent of 
the Analysis_Area_6000m layer.   

For each anthropogenic feature type listed in Table 1: 

CR7.1 Right click on the layer in the Table of Contents, click ‘Edit Features’, then click ‘Start 
Editing’. Using editing tools, modify and/or delineate features as needed. 

CR7.2 Open the attribute table and populate the ‘Type’ and ‘Subtype’ fields for each entry. Use the 
Type Code and Subtype Code for each attribute as provided in Table 1. Be sure to save edits 
and stop editing when done. 

Tips 
 Do not change the names of the ‘Anthro_*feature type*_Clip’ layers. If existing anthropogenic 

features of a specific type are digitized in a layer other than the ‘Anthro_*feature type*_Clip’ 
layer created in step D7, copy and paste those features into the appropriate ‘Anthro_*feature 
type*_Clip’ layer.  

▫ Click the Edit tool (          ) on the Editor toolbar 

▫ Click the feature you want to copy. Hold down SHIFT while clicking features to select 
additional features. 

▫ Click the Copy button (            ) on the Standard toolbar. 

▫ Click the Paste button (           ) on the Standard toolbar. 

▫ Click the ‘Anthro_*feature type*_Clip’ layer in which to store the pasted feature. 

▫ Click OK. The feature is pasted into the appropriate layer. 

 Do not digitize pipeline rights-of-way as roads, unless the right-of-way contains a road that 
meets the definitions in Table 1. Pipeline rights-of-way are a series of connected straight lines. 
Roads are mostly not perfectly straight lines. Anthropogenic features not described in Table 1 
are considered ‘de minimus’ and should not be digitized. 

~\ProjectName_YYYYMMDD\ProjectName_YYYYMMDD.gdb 
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 For mining or renewable energy facilities, proposed infrastructure such as roads and powerlines 
that are located within or immediately adjacent to anthropogenic features should be categorized 
as mining or renewable energy features. Proposed roads or powerlines that fall outside of the 
project footprint, such as those connecting the project to existing infrastructure, should be 
categorized as roads and powerlines. 

 Use the Data Driven Pages feature in ArcGIS to check your work before moving on:  

 Create a grid index to facilitate review of aerial imagery at approximately 1:5,000 scale.  

[ArcToolbox> Cartography Tools> Data Driven Pages> Grid Index Features] 
 Output Feature Class = a new layer named GridIndexFeatures 
 Input Features = Analysis_Area_6000m 
 Generate Polygon Grid that intersects input feature layers or datasets = checked 
 Use Page Unit and Scale = unchecked 
 Polygon Width = 1000 (in meters) 
 Polygon Height = 1000 (in meters) 
 All other fields = blank 

 Add the Data Driven Pages toolbar (Customize >Toolbars >Data Driven Pages), then 
set up data driven pages by clicking the Data Driven Page Setup icon (        ) and 
selecting GridIndexFeatures as the Layer. Leave all other options unchanged and click 
‘OK’. 

 Flip through every page using the next page icon (      ) for a thorough review. 

CR8.  Acquire the Dist_Lek layer from the Nevada Department of Wildlife (NDOW) 

CR8.1 Submit a Data Request Form, available from the NDOW website at 
http://www.ndow.org/Nevada_Wildlife/Maps_and_Data/Data/.  

CR8.2 Provide the Assessment_Area_6000m layer as the ‘Project Extent’. The 
Assessment_Area_6000m layer is saved as a shapefile in the project folder. Clarify that you 
are requesting the Dist_Lek layer for the purpose of assessing a project site for the 
Conservation Credit System. 

CR9.  Run Credit Tool Reclaim 4 
[ArcToolbox > CreditToolbox_Reclaim> Credit Tool Reclaim 4] 
 Project Geodatabase = the default project geodatabase for this project. 
 Nevada Data Package = the parent folder of the Nevada Data Package, named 

NevadaDataPackage_v1_3 
 Map_Units = the feature class or shapefile containing the delineated map units, most often 

the Map_Units layer. 
 Dist_Lek = represents the habitat quality associated with the distance to leks within the 

Analysis Area. Layer must be provided by NDOW. See step CR8. 

http://www.ndow.org/Nevada_Wildlife/Maps_and_Data/Data/
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Figure 28: Credit Tool Reclaim 4 interface 

Tips 
 The Dist_Lek layer should be scaled from ≥0 to ≤1 and have the same extent as the 

Analysis_Area_6000m layer. Ensure that this is the case. 

 If a feature class named Map_Units_Dissolve already exists in the project geodatabase (which 
may be the case if you did not follow these steps but delineated map units through a separate 
process), that feature class will be overwritten by Credit Tool Reclaim 4. You may either change 
that layer’s name (we recommend Map_Units_Copy) or save a copy outside of the project 
geodatabase if overwriting that layer is not desired. 

 If a feature class named Current_Anthro_Features already exists in the project geodatabase 
(which may be the case if you did not follow these steps but delineated anthropogenic features 
through a separate process), that feature class will be used by Credit Tool Reclaim 4, regardless 
of the feature class or shapefile provided to the tool as the parameter ‘Current_Anthro_Features’. 
If you do not wish to use that layer in Credit Tool Reclaim 4, remove it from the project 
geodatabase before running Credit Tool Reclaim 4. 

CR10.  Specify number of transects for each map unit 

CR10.1 Open the attribute table of the Map_Units_Dissolve layer. 

CR10.2 Populate the ‘Transects’ field for each map unit with the number of transects to be sampled 
within each map unit according to the necessary sampling intensity (see Appendix 2. 
Recommended Transects per Map Unit). For the map unit associated with existing surface 
disturbance, and any other map units where field data will not be collected, input ‘0’. See 
Appendix 2. Recommended Transects Per Map Unit for help determining number of 
transects required. 

CR10.3 Save edits and stop editing when done. 

~\NevadaDataPackage_v1_3 
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Tips 
 A number of transects should only be specified for map units that will be sampled in the field. 

For map units where field data will not be collected, input ‘0’ in the ‘Transects’ field. 

 Ensure that the total number of transects generated is equal to the number of transects desired. 

 If the first random bearing generated for a transect results in a transect that cannot be sampled 
by field crews, the next random bearing in the Transects attribute table should be used. See Field 
Data Collections Methods for more information. Two additional random bearings are generated 
for each transects. 

CR11.  Run Credit Tool Reclaim 5 
[ArcToolbox > CreditToolbox_Reclaim > Credit Tool Reclaim 5] 
 Project Geodatabase = the default project geodatabase for this project. 

 
Figure 29: Credit Tool Reclaim 5 interface 

CR12.  Run Credit Tool Reclaim 6 
[ArcToolbox > CreditToolbox_Reclaim > Credit Tool Reclaim 6] 
 Project Geodatabase = the default project geodatabase for this project. 
 Nevada Data Package = the parent folder of the Nevada Data Package, named 

NevadaDataPackage_v1_3 
 Project_Folder = the unique folder for this project that contains the default project 

geodatabase and the map document. 

 

Figure 30: Credit Tool Reclaim 6 interface 
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Tips 
 For small (< 0.5 acre) or narrow meadow map units for which local scale habitat functions are 

not calculated, complete the following steps.   

 In the Map_Units_Dissolve layer, select the Meadow map unit(s) that did not calculate a 
local scale habitat function or are smaller than 0.5 acres. 

 Using the Buffer tool, buffer the Map_Units_Dissolve layer by 20m (Note: You may need to 
buffer by a greater distance, however we want to use the smallest buffer possible). Name 
this layer Map_Units_Meadows. 

 [ArcToolbox> Analysis Tools> Proximity> Buffer] 
 Input Features = Map_Units_Dissolve, 
 Output Feature Class = Map_Units_Meadows, 
 Distance = 20 (in meters), 
 Side Type = FULL,  
 Method = PLANAR,  
 Dissolve Type = ALL, 
 Dissolve Fields = none checked. 

▫ Using the Zonal Statistics as Table tool, average all pixels of the Current_Local_Breed 
within each meadow map unit. Name the output tables as in 
ZonalSt_Current_Breed_Meadows.  

[ArcToolbox> Spatial Analyst Tools> Zonal> Zonal Statistics as Table] 
 Input raster or feature zone data = Map_Units_Meadows layer 
 Zone Field = ‘Map_Units_ID’ 
 Input value raster = Current_Local_Breed 
 Output table = ZonalSt_Current_Breed_Meadows 
 Ignore NoData in calculations = checked 
 Statistics type = MEAN 

▫ Repeat the previous steps for all local scale modifiers.  
▫ Using the Join Field tool, join the MEAN field for the ZonalSt_Current_Breed_Meadows 

table to the Map_Units_Meadows layer 

 [ArcToolbox> Data Management Tools> Joins> Join Field] 
 Input Table = Map_Units_Meadows layer 
 Input Join Field = Map_Unit_ID 
 Join Table = ZonalSt_Current_Breed_Meadows 
 Output Join Field = Map_Unit_ID 
 Join Field = check ‘MEAN’. 

▫ Repeat the previous step for all zonal statistics tables calculated.  
▫ Export the attribute table of the Map_Units_Meadows layer to a text file named 

‘Map_Unit_Meadows_Data’: 
 Open the attribute table of the Map_Units_Meadows layer. 

 Under ‘Table Options’ (  ) select Export and save as a .txt file. Name this file 
Map_Units_Meadows_Data. 

 When prompted to add the table to the current map, select ‘No’. 
▫ Add the Export Table to the blank workbook: 

 In the Data Ribbon, ‘Get External Data’ section, select ‘From Text’. 
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 Navigate to the Export Table and Open the Export Table. When opening, specify the 
file is comma-delimited. 

 Copy the relevant columns from the Export Table into the corresponding worksheets 
and columns in the Project Calculator. See Figure 31 for a list of Export Tables 
generated during the Desktop Analysis that must be inputted into the Calculator. 

 Add the local scale modifier data for the meadow map units to the corresponding map 
unit IDs in the Map_Units_Data excel file prior to entering the data into the HQT 
calculator. 

CR13.  Add the exported data to the Credit Project Calculator  

CR13.1 Open the Map_Unit_Data.xls, Transects_Data.xls and Mgmt_Cat_Data.xls files in Excel. 

CR13.2 Copy the relevant columns from the tables into the corresponding worksheets and columns 
in the Project calculator. See Figure 31 for a list of data generated during the Desktop 
Analysis that must be inputted into the Project HQT Calculator. 

 EXPORT TABLE CALCULATOR WORKSHEET 

□ Transects_Data 1.2 Enter Transects Data 

□ Mgmt_Cats_Data 1.3 Enter Mgmt Cats Data 

□ Map_Units_Data 1.1 Enter Map Unit Data 
 

Figure 31: Export Tables generated and corresponding Calculator worksheet 

Tips 
 The Calculator includes more detailed instructions for how to input data from each field 

datasheet. See rows 1 and 2 in the relevant worksheet in the Calculator. 

 After completing Credit Tool Reclaim 6, you are now ready to complete Section 2. Field Data 
Collection Method. The field crew will confirm the boundaries of map units, add or remove 
transect locations, and confirm the location of anthropogenic features. When field work is 
complete, make any necessary revisions to the Map_Units_Dissolve layer, Transects layer, and 
Current_Anthro_Features layer. 

 If the field crews recommend changes to the Map_Units_Dissolve layer, Transects layer, and 
Current_Anthro_Features layer, you must redo steps CR9 (Credit Tool Reclaim 4), CR11 (Credit 
Tool Reclaim 5) and CR12 (Credit Tool Reclaim 6)D13. Specify the updated 
Map_Units_Dissolve layer for the Map_Units parameter and updated 
Current_Anthro_Features layer for the Current_Anthro_Features parameter in Credit Tool 
Reclaim 4. Modify the Transects layer as necessary before running Credit Tool Reclaim 5. 
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2.  Field Data 
Collection Method 
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FIELD DATA COLLECTIONS METHODS 
The methods outlined below must be used for field data collection of attributes associated with the site 
scale, which defines habitat conditions at the site of proposed activities.  Table 2 describes the attributes 
measured to calculate site-scale functional-acres for specified seasonal habitats. 

TIMING OF FIELD DATA COLLECTION 

Vegetation sampling of sage-grouse habitat attributes must be conducted during the peak of the growing 
season. The peak of the growing season on northern Nevada rangeland generally occurs between April 
15th and June 30th. These dates may vary slightly annually due to temperature and precipitation. The 
peak of the growing season varies between sites based upon elevation, latitude, and winter and spring 
precipitation. Take annual and site variations into account when approximating the peak of the growing 
season within the permissible window for the site. Peak growing season is indicated when the culms of 
cool season grasses have fully elongated and seed heads have emerged (not necessarily seed-ripe) and the 
majority of forb species are between early bloom and seed set phenological stages.  

Field data must be collected during the permissible window in order for functional acre scores to be 
official and approved by the Administrator; however shrub data may be collected during any time of 
year. When making repeat visits to a site, attempt to collect data at a phenologically-similar time, or 
within two weeks of the first data collection for the site. 

FIELD MATERIALS REQUIRED 

The following materials should be collected before the field visit: 

1. Credit or Debit Project Calculator 
2. Hand-held sub-meter accuracy GPS unit, preloaded with transect start points 
3. Field maps, using aerial photos as background 
4. Datasheets 
5. Camera 
6. 50-meter tape 
7. Chaining pins 
8. 1-meter tape or wooden ruler 
9. PVC or wooden Daubenmire frame (20X50cm) 

10. White board for photo of transects or photo transect datasheets (Appendix 10: Photo Transect 
Datasheet)  

11. Rangefinder or 100-meter tape for distance to sagebrush 
12. Plant field guides for the area 
13. Walkie talkies (optional) 
14. Resistance & Resilience Scorecard & Guide, available at: 

http://www.fs.fed.us/rm/pubs/rmrs_gtr322.pdf 
15. A User’s Guide to Assessing Proper Functioning Condition and the Supporting Science for Lentic 

Areas and Lentic Checklist (if applicable), available at: 
http://www.blm.gov/or/programs/nrst/files/Final%20TR%201737-16%20.pdf>  

16. A User’s Guide to Assessing Proper Functioning Condition and the Supporting Science for Lotic 
Areas and Lotic Checklist (if applicable), available at: 
http://www.blm.gov/nstc/library/pdf/Final%20TR%201737-15.pdf>  

17. Ability to Control Wildfire Scorecard: Contact the Sagebrush Ecosystem Technical Team (SETT). 

  

http://www.fs.fed.us/rm/pubs/rmrs_gtr322.pdf
http://www.blm.gov/or/programs/nrst/files/Final%20TR%201737-16%20.pdf
http://www.blm.gov/nstc/library/pdf/Final%20TR%201737-15.pdf


 
 
NEVADA CONSERVATION CREDIT SYSTEM USER’S GUIDE PAGE 51 

CONSERVATION CREDIT SYSTEM USER’S GUIDE  
V1.3_AUTOMATED 

 

Table 2. Attributes measured and summary of data collection methods 

ATTRIBUTE RESOURCE SAGE-GROUSE SEASON  DATA COLLECTION SUMMARY 

Sagebrush canopy 
cover 

 

Cover 
 BREEDING 
 LATE BROOD-REARING The percent canopy cover is estimated 

with line intercept (% of sagebrush 
canopy intersecting transect line).  Cover and 

Foraging  WINTER 

Total shrub canopy 
cover (including 

sagebrush) 
Cover  BREEDING 

The percent canopy cover is estimated 
with line intercept (% of total shrub 
canopy intersecting transect line). 

Sagebrush height 
Cover and 
Foraging 

 WINTER 

The sagebrush height is determined 
by measuring the tallest point of a 
shrub that is intersecting the transect 
line. 

Distance to 
sagebrush cover Cover -Trigger  LATE BROOD-REARING 

Distance to nearest sagebrush cover 
(cover equivalent to area of at least 
~30x30 m, with density of 10% canopy 
cover, and average height of 30cm) is 
measured from the 30 m point along 
each 50 m transect. 

Perennial forb 
canopy cover  Foraging 

 BREEDING 
 LATE BROOD-REARING 

Percent cover of perennial forbs is 
determined by sampling within a 
standard-sized Daubenmire plot 
(20x50 cm) at 10 meter increments 
along a 50 m transect (5 plots total/ 
transect).  

Forb species 
richness (# of 

species)   
Foraging 

 BREEDING 
 LATE BROOD-REARING 

Abundance of forbs (annual and 
perennial) is determined by sampling 
within a standard-sized Daubenmire 
plot (20x50 cm) at 10 meter increments 
along a 50 m transect (5 plots total/ 
transect).  

Perennial grass 
canopy cover 

Cover-Trigger  BREEDING 
Species and percent cover of perennial 
grasses is determined by sampling 
within a standard-sized area of 
Daubenmire plot (20x50 cm) at 10 
meter increments along a 50 m 
transect (5 plots total/ transect). 

Cover  LATE BROOD-REARING 

Invasive annual 
grass canopy cover 

Modifier  BREEDING 
 LATE BROOD-REARING 

Percent cover of annual grasses is 
determined by sampling within a 
standard-sized area of Daubenmire 
plot (20x50 cm) at 10 meter increments 
along a 50 m transect (5 plots total/ 
transect). 
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DETAILED INSTRUCTIONS 

F1. Conduct Site Reconnaissance 
Upon arrival at the site, field crews should walk the site together to quality-check the map unit 
delineations. Map units, especially in agricultural and meadow areas, often change from year to year, and 
may not reflect even relatively recent aerial photography. As well, changes in some vegetation 
communities may not be evident on aerial photographs, such as understory composition.  Crews should 
be prepared to modify map unit boundaries (both further sub-dividing maps units and conglomerating 
existing maps units) in the field based on observations, and should also come to a common 
understanding of the plants present, and the protocol that follows. Any changes to map units must be 
noted and map unit and relevant GIS data files must be corrected after field work is complete. In 
addition, if sites have high variability that cannot be accounted for through changes in map unit 
delineations, additional transects should be added to the protocol based on the best judgement of the 
verifier.  

F2. [Repeat Steps F3 - F9 for each Map Unit] 

F3. Complete Map Unit Datasheet 
The map unit datasheet should be the first form filled out when arriving at the site and continued to be 
filled out as the sampling is completed (see Appendix 7: Map Unit Datasheet).  For each map unit, record 
the date, map unit description, and other mandatory information.  The total number of map units 
sampled within the project site should be counted and recorded after all map units have been sampled. 

F4. Complete Resistance & Resilience Scorecard 
Complete the Resistance and Resilience Score Sheet for each ecological site/map unit within the project 
area (see Field Materials Required, the Resistance & Resilience Scorecard should have been partially filled 
out during the Desktop Analysis), referring to the accompanying field guide3. One Resistance and 
Resilience Score Sheet can be used for multiple map units that are anticipated to have the same result 
based on site conditions. Once the score cards are complete, an area weighted average score for the 
project site should be calculated and entered into the Calculator on the Baseline and Reserve Account tab.  

F5. Complete Ability to Control Wildfire Scorecard 
Complete Wildfire Score Sheet for each ecological site/map unit within the project area (see Field Materials 
Required, the Wildfire Scorecard should have been partially filled out during the Desktop Analysis), 
referring to the accompanying field guide. One Wildfire Score Sheet can be used for multiple map units 
that are anticipated to have the same result based on site conditions. Once the score cards are complete, 
an area weighted average score for the project site should be calculated and entered into the Calculator 
on the Baseline and Reserve Account tab.  

F6. Complete Lentic or Lotic PFC Checklist (if applicable) 
Complete the Lentic or Lotic PFC Assessment Checklists for the credit projects only. 

F7. [Repeat Steps F8 - F9 for each Transect] 

F8. Navigate to Transect and Begin Data Collection 

F8.1 Establishing a Transect 

F8.1(a) Navigate to a transect start point via hand-held GPS. Insert a chaining pin in the 
ground, and lay out or thread a 50-meter transect using the random bearing 

                                                           
3 Miller, Richard F.; Chambers, Jeanne C.; Pellant, Mike. 2014. A field guide for selecting the most appropriate 
treatment in sagebrush and piñon-juniper ecosystems in the great basin: Evaluating resilience to disturbance and 
resistance to invasive annual grasses, and predicting vegetation response. Gen. Tech. Rep. RMRS-GTR-322 REVISED. 
Fort Collins, CO: U.S. Department of Agriculture, Forest Service, Rocky Mountain Research Station. 66 p. 
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generated for that transect. Pull the tape taut and anchor the 50 m end with a 
chaining pin. Populate all fields at the top of transect datasheet (Appendix 9: 
Transect Datasheet), with the date, observer initials, site name, map unit number, 
the transect number and UTMs (including UTM Zone and Datum), GPS type, 
transect bearing, whether the transect is within an altered or unaltered meadow, 
photo point numbers, and camera type. 

 

 
F8.1(b) Transects will be named as followed: XXX-MU#-T#  
F8.1(c) XXX is three letter abbreviation for project site, MU# is the map unit number, and T# 

is the transect number, all of which should be named based on information from the 
pre-field work desktop analysis.  

F8.2 Photo Points 

F8.2(a) Using a white board label it with the project site, date, transect name, and transect 
direction. Lean it next to the chaining pin it at the 0 meter mark of the transect. 

F8.2(b) Align camera in direction of the transect so that the bottom of the white board is at 
the photo’s bottom center (Figure 32). 

F8.2(c) Take photo and, if using GPS camera, name the photo using transect name. 

 

 
Figure 32. Transect photo example 

NOTE: If a transect crosses a map unit boundary into another map unit or outside of the project area, 
the transect will need to be reflected back into the map unit by 90 degrees, priority to the 
right, if not, then left. If that doesn’t work pick the next randomly generated point in that map 
unit. 

 
NOTE: If a transect passes through a shrub thicket too dense to sample properly (i.e., willow, 

serviceberry, mahogany, desert peach, etc.) at a distance of greater than 50 m, reflect the 
transect 90 degrees to the right, then left. If reflecting does not work pick the next randomly 

       

 

 

NOTE: For data collection: Always stand on the right side of the transect. Field data should be 
collected on the left side of the transect. 
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F9. Daubenmire Plots  

F9.1 Daubenmire Frame Placement 

F9.1(a) Place the top of a Daubenmire frame on the left side of the transect line starting at 
the 10 meter mark (see Figure 33). The frame should be placed with the long side 
parallel to the transect.  Take care not to damage any vegetation. Repeat these 
placements every 10 m, for a total of 5 plots along the 50 m transect.  

F9.2 Grass and Forb Cover 

F9.2(a) Record all grass and forb cover that falls within the plot using the following cover 
classes listed in Table 3. If the plant is rooted outside the plot, but its cover falls 
within the plot, those estimates should be counted towards cover. Do not include 
cover of a plant that falls outside of the plot, even if the plant is rooted within the 
plot.  

F9.2(b) Identify cover for each of the following functional group categories: 

▫ PF = perennial forb (live cover only) 
▫ PG = perennial grass (live or residual) 
▫ IAG = invasive annual grass (live or residual) 

Table 3. Cover classes for use when estimating cover in Daubenmire frames 

COVER CLASS RANGE OF COVER (%) MID-POINT OF CLASS (%) 

1 0-5 2.5 
2 5-25 15.0 
3 25-50 37.5 
4 50-75 62.5 
5 75-95 85.0 
6 95-100 97.5 

 

NOTE: All species from Line intercept, Daubenmire plots, and general species lists, should be 
recorded using the following nomenclature.  Species names should be recorded using full scientific 
name or the USDA PLANTS database species code (http://plants.usda.gov/). 

If you can identify the genus, but not the species either use the PLANTS database genus code 
(http://plants.usda.gov). ALWAYS define the genus portion of the code in the notes section of the 
transect datasheet (e.g., Artemisia species = AR01). In addition, note if it is annual or perennial for 
forbs and graminoids. 

Do not use common names.  

If you cannot identify the genus, use the following codes and a short description/drawing: 

 AF# = Annual forb (also includes biennials) 
 PF# = Perennial forb 
 AG# = Annual graminoid 
 PG# = Perennial graminoid 
 SH# = Shrub 
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F9.3 Forb Species Count 

F9.3(a) For each Daubenmire plot, record the USDA PLANT code or scientific name for 
each forb species that are rooted within the plot, annual and perennial. Once all 5 
plots are completed for a transect, tally and record the count of all forb species 
identified within the 5 plots, this will give you a total forb species count per transect.  

F9.3(b) Record all plant species encountered along the transect in the notes section of the 
datasheet.  

F10. Distance to Sagebrush Cover 

F10.1 Measure the distance to the nearest sagebrush, or sagebrush mixed shrub community, cover 
from the 30 m mark of the transect and record the distance in meters on the datasheet.  

F10.1(a) Sagebrush or sagebrush mixed shrub community cover must have at least of 10% 
canopy cover in a minimum 30x30 m patch size with average height of 30 cm.  

F10.1(b) If the transect is located within sagebrush cover, then record distance as 0 m.  

F11. Line Intercept 

F11.1 Shrub Canopy Cover 

F11.1(a) You can begin at the 0 m or the 50 m mark for line intercept. For the entire length of 
the transect, record start and stop locations (in centimeters) for all shrub species 
intercepting the transect using the following categories:  

▫ Low sagebrush  
▫ Big sagebrush  
▫ Other   

F11.1(b) Interceptions less than 5 cm are not recorded as canopy cover. 
F11.1(c) If a gap is greater than 5 cm stop your intercept recording. Resume intercept once 

you reach canopy cover that is greater than 5 cm.  
F11.1(d) Canopy cover for each shrub species is recorded, even if multiple species are 

overlapping.  

 

NOTE: The following invasive annual grass species should be included, but not limited to, in the 
estimate of annual invasive grass cover:  

 Cheatgrass (Bromus tectorum) 
 Medusahead (Taeniatherum caput-medusae) 
 Red Brome (Bromus rubens) 
 Rattlesnake chess (Bromus briziformis) 

NOTE: The total lengths of shrubs will be added together over the 50 meters to calculate the percent 
canopy cover of sagebrush and total shrubs.  

 

 

 



 
 
NEVADA CONSERVATION CREDIT SYSTEM USER’S GUIDE PAGE 56 

CONSERVATION CREDIT SYSTEM USER’S GUIDE  
V1.3_AUTOMATED 

 

 
F11.2 Sagebrush Height 

F11.2(a) For each sagebrush plant intercepting the transect, record the tallest vegetative 
portion to the nearest cm. Do not include the inflorescence of sagebrush as height. 

 
 

 

 

 

 

 

 

 

 

 

 

Figure 33. Diagram of transect and plots 

F12. Document Anthropogenic Features 

F12.1 The anthropogenic features map developed in the pre-field desktop analysis should be 
ground-truthed on foot or in a vehicle.  Additional features that are identified should be 
marked on the map and digitized in the office in ArcGIS; similarly GPS coordinates collected 
and recorded in the field should be added to ArcGIS in the office.  

F12.2 Newly identified features should be noted on the anthropogenic features datasheet for the 
project site.  

F12.2(a) If features are marked on the map, be sure to attach map to the anthropogenic 
features datasheet.  

NOTE: The following sagebrush species are the species of sagebrush in Nevada that the CCS 
recognizes. No other species should be counted as sagebrush. For example, Artemisia spinescens, 
Artemisia ludoviciana, while they are “sage” species, they should not count as sagebrush, but are 
considered as “other” shrub canopy cover.  

 Artemisia arbuscula 
 Artemisia cana 
 Artemisia frigida  
 Artemisia longiloba 
 Artemisia nova 
 Artemisia papposa 
 Artemisia tridentata ssp. tridentata 
 Artemisia tridentata ssp. vaseyana 
 Artemisia tridentata ssp. wyomingensis 
 Artemisia tripartita 
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F12.2(b) If features are marked using GPS, be sure to record GPS unit name and use the 
following naming code: XXX- # where XXX is the three letter abbreviation for project 
site, and # is a unique sequential number for each feature identified in the field. 

F13. Input Data into Credit or Debit Project Calculator 

 
F13.1 Open the Project Calculator. 

For each Field Datasheet: 

F13.2 Enter the relevant data into the corresponding worksheets and columns in the Calculator. See 
Table 4 for a list of field datasheets completed during the field data collection that must be 
inputted into the Calculator. 

Table 4. Field Datasheets completed during the Field Data Collection and corresponding Calculator Worksheet 

 FIELD DATASHEETS REFERENCE 
STEP CALCULATOR WORKSHEET 

□ Map Unit Datasheets F3 2.1 Track Field Sheets 

□ Resistance & Resilience Scorecard F4 3.1 Enter Baseline & Rsrv Acct 

□ Proper Functioning Condition Checklist F6 2.1 Track Field Sheets 

□ Ability to Control Wildfire F5 2.1 Track Field Sheets 

□ Transect Datasheets F8 - F9 
2.2 Enter Field Info 
2.3 Enter Shrub Data 
2.4 Enter Forbs & Grass Data 

 

 
  

DATA REQUIRED: All Field Datasheets completed during the Desktop Analysis, Credit or Debit 
Project Calculator 

NOTE: The Calculator includes more detailed instructions for how to input data from each field 
datasheet. See row 1 in the relevant worksheet in the Calculator.  
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3.  Credit/Credit 
Obligation 
Calculation 
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CREDIT/CREDIT OBLIGATION CALCULATION 
This section provides a step-by-step overview of the process for generating credits and securing credits to 
offset a credit obligation. These steps will be completed by the Credit Developer/Credit Buyer, Technical 
Service Providers, Verifiers and the Credit System Administrator, depending on their roles and skillsets. 
Please contact the Sagebrush Ecosystem Technical Team (SETT) with questions on any step in this 
process. 

TOOL PREREQUISITES 

 Credit or Debit Project Calculator (NOTE: Section 1: Desktop Analysis and Section 2: Field Data 
Collection Methods contain critical information on completing the Calculator.) 

 Credit Projects 
▫ Validation Checklist (completed) 
▫ Verifier Conflict of Interest Form 
▫ Management Plan 
▫ Participant Contract 
▫ Annual Monitoring Form 
▫ Notice of Validation 

 Debit Projects: 
▫ SETT Consultation Form 
▫ Verifier Conflict of Interest Form 
▫ Anthropogenic Disturbance Review Form 
▫ Verification Contract 
▫ Credit Purchase Agreement 
▫ Credit Transfer Form 
▫ Notice of Transfer 

 Recommended: Current versions of the Nevada Conservation Credit System Manual and HQT 
Methods document for reference. 

DETAILED STEPS TO CALCULATE CREDITS 

The User’s Guide covers steps D2 in Section 3.1: Generating Credits of the Nevada Conservation Credit 
System Manual (Figure 34).  

 
Figure 34. Overview of the process steps to generate credits 

D2.1 CALCULATE PRE-PROJECT CONDITIONS 

D2.1.1 Calculate Credits for Pre-Project Conditions  

Open the Credit Project Calculator. 

Review habitat function and functional acre scores based on current conditions presented in worksheet 
3.2 Review Credit/Debit Amount to ensure data has been inputted accurately. If not, review Section 1: 
Desktop Analysis or Section 2: Field Data Collection Methods for instructions for generating and entering 
local-scale and site-scale data. 

 Select & 
Validate 

Site 

 Calculate 
Credit & 

Implement 

 Verify 
Conditions 

 Register &   
Issue 

 Track &   
Transfer 
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Enter relevant WAFWA Management Zone and factors that determine the reserve account contribution 
into worksheet 3.1 Enter Baseline & Rsrv Acct. 

Conduct quality assurance effort by thoroughly reviewing the GIS process and products, baseline habitat 
function, current habitat function, current functional acres, current mitigation ratio and current credits 
generated values in worksheet Summary to ensure values makes sense based on general and 
observational understanding of the project site. 

D2.2 DEFINE & SUBMIT PROJECT DESIGN INFORMATION 

D2.2.1 Complete Section I of the Management Plan 

Complete Section I of the Management Plan according to guidance provided in the form. For restoration 
or enhancement projects, use a draft Management Plan to outline design options for the project and 
describe expected outcomes. These design options will be evaluated in the Calculator to calculate 
expected credits generated by the project. 

D2.2.2 Estimate Post-Project Credits  

In the Calculator, estimate post-project credits by entering projected post-project conditions based on 
project design options in the Management Plan into worksheet 2.7 Enter Projected Conditions.  

Projected post-project conditions are entered into the Projected Post-Project Habitat Function and 
Projected Post-Project Mitigation Ratio data entry columns. For cells left blank in these data entry 
columns, the current conditions are used for calculating projected post-project conditions. 

Review the projected post-project credit calculations in worksheet Summary. 

Print the updated Credit Summary from worksheet Summary and copy/paste Credit Summary into the 
corresponding section of the draft Management Plan. 

D2.3 IMPLEMENT PROJECT, REFINE CALCULATIONS & SUBMIT 

D2.3.1 Confirm or Refine Credit Calculations 

Implement the project and repeat the credit calculation if the project was not consistent with the draft 
Management Plan. Modify the Calculator and repeat steps in the Desktop Analysis if necessary. This is 
the final, official credit calculation. If changed, print the updated Credit Summary from worksheet 
Summary and copy/paste Credit Summary into the corresponding section of the draft Management Plan. 

D2.3.2 Determine Reserve Account Contribution 

Enter the area-weighted Resistance and Resilience scores from the Score Sheets completed in step F4 into 
worksheet 3.1 Enter Baseline & Rsrv Acct of the Calculator.  

Enter the area-weighted Ability to Control Wildfire Score Sheet score for the credit project.  

Complete the Competing Land Use assessment and input contribution percentage from Table 5 for 
projects on private land into Worksheet 3.1 Enter Baseline & Rsrv Acct of the Calculator. See the 
Management Plan for information necessary to complete the Competing Land Use assessment. Projects 
on public lands have not yet been approved by federal land management agencies; please contact the 
Administrator for more information. 
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Table 5.Competing Land Uses reserve account categories and contribution percentages for credits on privately-owned land 

MINIMUM COMPETING LAND USE RELATED 
REQUIREMENTS 

CONTRIBUTION 
PERCENTAGE 

Participant Contract and  
Conservation Easement and  

Ownership of Subsurface Rights 
0% 

Participant Contract and  
Conservation Easement 1% 

Participant Contract and  
Ownership of Subsurface Rights 3% 

Participant Contract 4% 
 

 
D2.3.3 Determine Credit Release Schedule 

Review the pre-project credit calculation to the expected post-project credit calculation in worksheet 
Summary.  Use this information to fill out the Credit Release Schedule in Section II of the Management 
Plan. 

D2.3.4 Calculate Financial Assurances 

Complete the management actions table in Section III of the Management Plan to estimate the cost for 
long-term management of the credit project. Use this section to determine the amount required for 
financial assurances for the project. Fill out Section IV of the Management Plan with financial assurance 
information. Contact the Administrator for any needed guidance.  

D2.3.5 Set Verification Schedule 

Complete the independent verification schedule in Section III of the Management Plan. 

D2.3.6 Complete Participant Contract  

 Fill out and sign the Participant Contract. 

  

NOTE: After you feel confident in all your results, you are now ready to place Post-Field Work 
Submittals in a folder on the ftp site for SETT Review. This folder should include all GIS data 
within a geodatabase with the appropriate naming conventions, transect datasheets, photo-
point-datasheets, field maps, meaningful notes, anthropogenic disturbance review forms, PFC 
checklists for each riparian area, R&R and Wildfire scorecards representing each map unit, 
the completed HQT calculator indicating the credit estimate, the Verifier Project Assessment 
Submission Form, as well as notes on any assumptions made, potential discrepancies, issues, 
etc. Please download the Post-Field Submission Guidance folder from the ftp site for further 
details and the necessary forms,  
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DETAILED STEPS TO CALCULATE CREDIT OBLIGATION 

The User’s Guide covers steps B2 – B3 in Section 3.2: Acquiring Credits of the Nevada Conservation Credit 
System Manual for regulatory offset credit Buyers only (Figure 35). Before beginning, ensure the project 
has been planned in a way that avoids and minimizes residual impact to the maximum practical extent. 
Review Section 3: Credit System Operations of the Manual for more information. 

 
Figure 35. Overview of the process to calculate credit obligation and acquire credits 

B2.1 DETERMINE CREDIT OBLIGATION AMOUNT 

B2.1.1 Establish Verification Contract 

Complete a Verification Contract with the Credit Buyer. 

B2.1.2 Estimate Credit Obligation 

Open the Debit Project Calculator. 

Review all tabs to ensure data has been inputted accurately. If not, review Section 1: Desktop Analysis or 
Section 2: Field Data Collections Methods for instructions. 

In the Debit Project Calculator, review preliminary credit obligation calculation in worksheet Summary. 
This is the pre-implementation credit obligation estimate. 

D2.1.3 Verify Debit Estimates 

If field data was collected by the Credit Buyer, verify that field data collection was completed accurately. 

 
D2.1.4 Verify Post-Project Conditions 

After the project has been implemented, verify that project design plans were followed and that the 
original credit obligation estimate is still accurate. If not, repeat Desktop Analysis steps necessary to 
recalculate credit obligations based on actual post-project conditions. 

D2.1.5 Purchase Credits 

The Credit Buyer will be provided a list of credit projects that could meet the Credit Buyer’s credit 
obligation. The Credit Buyer then selects one or more potential credit projects and contacts the Credit 
Developer. The Credit Developer and Credit Buyer come to agreement on credit quantities, price, timing 
of funding, and other terms. Once an agreement is complete, the Credit Buyer or Credit Developer 
submits the Credit Transfer Form to the Administrator. 

  

  Acquire 
Credits 

 Determine 
Credit Need 

Indicate 
Interest 

 Track & 
Transfer 

NOTE: After you feel confident in all your results, you are now ready to place Post-Field Work 
Submittals in a folder on the ftp site for SETT Review. This folder should include all GIS data 
within a geodatabase with the appropriate naming conventions, transect datasheets, photo-
point-datasheets, field maps, meaningful notes, anthropogenic disturbance review forms, the 
completed HQT calculator indicating the credit estimate, the Verifier Project Assessment 
Submission Form, as well as notes on any assumptions made, potential discrepancies, issues, 
etc. Please download the Post-Field Submission Guidance folder from the ftp site for further 
details and the necessary forms,  
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APPENDICES 
Appendix 1. Guidance For Delineating Map Units 

Appendix 2. Recommended Transects Per Map Unit 

Appendix 3. Quick Reference Guide: Debit Projects 

Appendix 4. Quick Reference Guide: Credit Projects That Do Not Propose To Modify Existing 
Anthropogenic Features 

Appendix 5. Quick Reference Guide: Credit Projects That Propose To Modify Existing Anthropogenic 
Features 

Appendix 6. Resistance & Resilience Scorecard 

Appendix 7: Map Unit Datasheet 

Appendix 8: Ability To Control Wildfire Scorecard 

Appendix 9: Transect Datasheet 

Appendix 10: Photo Transect Datasheet 

Appendix 11. Anthropogenic Features Datasheet 
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Appendix 1. Guidance for Delineating Map Units  

Project Area: The project area is the area that is being evaluated, and includes all habitats within the 
boundaries of what is delineated as the project area. For credit projects, the project area is the extent of the 
obligation by the credit developers. For debit projects, the project area is the extent of the proposed 
surface disturbance plus the indirect effects area.  

Map Units: The map units are sub-divisions of the project area based on unique vegetation communities, 
structure, and site potential.  Map units need to be 
defined in order to capture differences in the site-
scale habitat attributes assessed to more accurately 
inform the functional acre scores. See the Field Data 
Collection Methods for a list of attributes assessed. 
When delineating map units, it is important to keep 
these attributes in mind as they are the drivers of 
the habitat function scores. For example, map units 
should be delineated based on expected variation 
in sagebrush canopy cover and distance to 
sagebrush cover. Elevation, slope, aspect, soil type 
and other factors should also be considered, as they 
may impact vegetation distribution. 

Although map units can be somewhat subjective, a 
map unit should encompass a relatively 
homogenous area of vegetation. Map units should 
also be delineated based on the potential of the site 
to support a particular vegetation community, so 
that map unit boundaries will not become less relevant over time. Map units should be delineated based 
on ecological sites, recent aerial photography, and ground verification. Major breaks such as changes in 
vegetation community, relative abundance of species, water vs. terrestrial, shrub land vs. meadow, and 
roads vs. undeveloped area, are relatively straight-forward to delineate via aerial photography. In 
addition, supplemental data layers within GIS can help identify other distinctions such as changes in 
topography (elevation, slope, and aspect) or soils which may affect vegetation composition. Defining map 
units requires a good working knowledge of the habitats important to sage-grouse and local site 
conditions. If possible, a site visit is encouraged to help inform the map unit delineation process prior to 
initiating the Desktop Analysis. Map unit boundaries may also be modified based on site conditions 
identified during field data collection. If the field crews recommend changes to the Map_Units_Dissolve 
layer, you must update the Map_Units_Dissolve layer and redo steps D9/C7/CR9, and D12/C10/CR12. 
Specify the updated Map_Units_Dissolve layer for the Map_Units parameter in step D9/C7/CR9. 

Additional rules for map unit delineation: 

1. Minimum map unit size should generally be 0.5 acres, unless there are features such as stringer 
meadows that are appropriate to delineate at a smaller scale. 

2. Clusters of willow or other dense catches of woody riparian vegetation within meadows should 
not be delineated as separate map units. However, transects should not be run through the areas 
of dense willow patches.  

3. For debit projects, map units should first be delineated by indirect disturbance area, proposed 
surface disturbance, and already existing disturbance areas. Indirect and proposed should then 
be further subdivided according to the standards guidelines. No sampling will occur in existing 
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disturbance areas, so no further subdivision is needed. This map unit will be assigned a site scale 
score of zero and no transects will be generated in this map unit. 

4. For debit projects, term features should be separate map units from permanent features. 

5. For credit projects, treatment areas where a change in the site scale score is anticipated should be 
delineated as separate map units. (Even if currently they are similar in vegetation to other areas, 
but a change is not expected in those areas.) 
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Appendix 2. Recommended Transects Per Map Unit 

This section provides guidance for the number of transects per map unit based on area and variability of 
the habitat within the map unit.  When delineating map units, the technician should seek to maximize 
map unit area while minimizing variability within each map unit. Once map units are defined, the 
sampling intensity (number of transects per map unit) should be determined based on the acreage of the 
map units and the relative homogeneity of vegetation within the map unit. Table 6 contains the minimum 
number of transects required for each map unit, based on map unit size. When delineating map units 
using aerial imagery, the technician should note which map units have a mosaic of vegetation or 
patchiness that may require a greater level of sampling intensity. Similarly, map units which are more 
obviously homogeneous should be noted as they may require a lower level of sampling intensity.  

Table 6. Minimum number of transects required based on map unit acreage 

Map Unit Size: 0.5 TO <40 
ACRES 

40 TO <640 
ACRES ≥640 ACRES 

Transects per 
Map Unit: 2 - 3* 4 - 8* 8 - 16* 

*Choose the higher end of the range for map units with higher variability. 

In the field, the variability within each map unit will be evaluated before moving on to sample the next 
map unit. If the variability and number of samples does not provide sufficient confidence in the 
parameter estimate for each attribute measured, additional samples will be taken from the map unit. The 
process for generating new transects and calculating the number of additional transects to be sampled is 
described in the Field Data Collections Method section.  

Additional guidance for generating random transect locations and bearings: 

1. Transects that are impeded by clusters of willow or other dense patches of riparian woody 
vegetation within meadows should be discarded and alternative, random sample points should 
be generated. To avoid creating an incentive to modify riparian habitat that supports sage-grouse 
habitats but is not used directly by sage-grouse, and thus does not receive credits, clusters of 
willows or other riparian woody vegetation will receive the habitat function score of the map unit 
that it is contained within. 

2. If a transect will cross a map unit boundary into another map unit or outside of the project area, 
the transect will need to be reflected back into the map unit by the field crew and continued. Do 
not discard transects near map unit boundaries, as this would bias results. 

Do not sample transects that originate in or cross existing surface disturbance. Discard and select an 
alternative, random sample point. 
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Appendix 3. Quick Reference Guide: Debit Projects  

  

• Add Proposed_Surface_Disturbance 
• Run Debit Tool 1 
• Edit Proposed_Surface_Disturbance_Debits 
• Digitize outer extents of proposed anthropogenic features and review pre-populated 

information for accuracy.  
• Populate or update ‘Type’, ‘Subtype’, ‘Term’, and ‘Rehab’ fields for each feature. 
 

• Run Debit Tool 2 
• Divide Map_Units into discrete map units 

• Populate or update ‘Type’, ‘Subtype’, ‘Term’, and ‘Rehab’ fields for each feature.  
 

• Run Debit Tool 3 
• Edit each Anthro_*feature type*_Clip layer to identify existing anthropogenic 

disturbances within the Analysis_Area_6000m layer.  
• Populate the ‘Type’ and ‘Subtype’ fields for each feature layer.  
 

• Run Debit Tool 4 
• Populate the 'Transects' field of the Map_Units_Dissolve layer with the number of 

transects to be sampled within each map unit.  
 

• Run Debit Tool 5 
 

• Run Debit Tool 6 
• Open the export tables Transects_Data, Mgmt_Cats_Data, and Map_Units_Data in Excel. 

Add relevant columns from the tables into the Project HQT calculator.  
 

Debit Tool 2 
 

Debit Tool 3 
 

Debit Tool 4 
 

Debit Tool 5 
 

Debit Tool 6 
 

Debit Tool 1 
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Appendix 4. Quick Reference Guide: Credit Projects That Do Not Propose to Modify 
Existing Anthropogenic Features 

  

• Add the Credit_Project_Boundary to ArcMap.  
• Run Credit Tool 1 
• Divide the Map_Units layer into discrete map units.  

• Populate the ‘Map_Unit_ID’, ‘Map_Unit_Name’, ‘Meadow’, and ‘Precip’ fields 
 

• Run Credit Tool 2 
 

• Run Credit Tool 3 
• Populate the ‘Transects’ field of the Map_Units_Dissolve layer with the number of 

transects to be sampled within each map unit. 
 

• Run Credit Tool 4 
 

• Run Credit Tool 5 
• Open the export tables Mgmt_Cats_Data, and Map_Units_Data in Excel. Add relevant 

columns from the tables into the Project HQT calculator.  
 

Credit Tool 2 
 

Credit Tool 3 
 

Credit Tool 4 
 

Credit Tool 5 
 

Credit Tool 1 
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Appendix 5. Quick Reference Guide: Credit Projects That Propose to Modify Existing 
Anthropogenic Features 

  
• Add the Credit_Project_Boundary to ArcMap 
• Run Credit Tool Reclaim 1 
• Edit Proposed_Modified_Features   
• Digitize outer extents of proposed anthropogenic features and review pre-populated 

information for accuracy.  
• Populate or update ‘Type’ and ‘Subtype’ fields for each feature. 

 

• Run Credit Tool Reclaim 3 
• Edit each Anthro_*feature type*_Clip layer to identify existing anthropogenic disturbances 

within the Analysis_Area_6000m layer.  
• Populate the ‘Type’ and ‘Subtype’ fields for each feature layer. 
• For any anthropogenic features proposed to be modified, change the field 

  

• Run Credit Tool Reclaim 3 
• Edit each Anthro_*feature type*_Clip layer to identify existing anthropogenic disturbances 

within the Analysis_Area_6000m layer.  
• Populate the ‘Type’ and ‘Subtype’ fields for each feature layer. 
• For any anthropogenic features proposed to be modified, change the field 

  

• Run Credit Tool Reclaim 4 
• Populate the ‘Transects’ field of the Map_Units_Dissolve layer with the number of 

transects to be sampled within each map unit.  
 

• Run Credit Tool Reclaim 5 
 

• Run Credit Tool Reclaim 6 
• Open the export tables Mgmt_Cats_Data, and Map_Units_Data in Excel. Add relevant 

columns from the tables into the Project HQT calculator. 
 

Credit Tool 
Reclaim 2 

Credit Tool 
Reclaim 3 

Credit Tool 
Reclaim 4 

Credit Tool 
Reclaim 5 

Credit Tool 
Reclaim 6 

Credit Tool 
Reclaim 1 
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Appendix 6. Resistance & Resilience Scorecard 
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Score Sheet for Rating Resistance and Resilience to Disturbance to Invasive Annual 
Grasses in the Great Basin (adapted from Miller et al. 2014) 

Ecological Site Name and Number Desktop 

PLOT SCORE 
% of Project Area: Desktop UTMs: On-Site 

SITE CHARACTERISTICS DESCRIPTION OF SCORES 1 2 3 4 5 
Temperature (Soil temperature regime  + Species or subspecies of sagebrush) Desktop 

Soil temperature regime 

1=hot-mesic; 2=warm-mesic; 
3=cool-mesic or cool-cryic; 
4=warm frigid; 5=cool-frigid; 
6=warm-cryic 

    1 

Species or subspecies of 
sagebrush 

1=Wyoming, low, black, or 
Lahontan; 2=basin, Bonneville, or 
xeric, 3=mountain 

    1 

A. Temperature Score =  Subtotal     2 

Moisture (Precipitation  = Soil Texture = Soil Depth)  Desktop 

Precipitation in inches (in) 1= <10; 2= 10-12; 3= 12-14; 4= 
>14 

    1 

Soil texture 1=clay, sand, or silt; 2=silty, 
sandy, or clay loam; 3=loam 

    2 

Soil depth in inches (in) 
0= very shallow (<10); 1= 
shallow (10-20); 3= moderately 
deep to deep 

    3 

B. Moisture Score = Subtotal     6 

Vegetation (Plant groups modified by soil depth) On-Site 
Plant Groups 
Deep-rooted perennial grasses 

(DRPR) potentially dominant in 
shallow to deep soils >10 in. 

Sandberg bluegrass (POSE) 
potentially dominant in very 
shallow soils <10 in. 

Perennial forbs (PF) 
Invasive annual grasses (IAG) 
 

0=DRPG and POSE scarce to 
severely depleted (DRPG < 2-
3/m2) and less than 5% foliar 
cover 

3= DRPG on soils >10 in. scarce, 
but POSE of PF >50% foliar 
cover  

6= DRPG on soils >10 in. 
depleted (2-3/m2 or about 5-
10% foliar cover) and/or co-
dominant with IAG, or on soils 
< 10 in. POSE and PF 5-15% 
foliar cover and co-dominant 
with IAG. 

9= DRPG and PF dominant on 
soils > 10 in.  or POSE and PF 
dominant on soils < 10 in. 

    3 

C. Vegetation Score Subtotal     3 

SITE SCORE = A + B + C      11 

R & R RATING (circle one) Very low < 10; Low = 10-14; Moderate  = 15-20; High > 20 
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Appendix 7: Map Unit Datasheet 
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Project Site Name:   Page  1  
Total number of Map units within Project Site:  Version: SETT 06-12-17 

   

Map Unit Number: Dates of map unit transects: 

Total number of transects:  
Names of transects: 

Total number of photos:  
Aspect of MU:                                          Slope of MU: 

Map Unit Description (1 to 2 sentences describing vegetation, topography, and other features relevant 
to sage-grouse within map-unit): 
  
  
  

Season during which this map unit was evaluated (circle):     nesting     late brood-rearing     winter 

Indicate potential seasonal habitats in this map unit (circle):     nesting     late brood rearing     winter 

Should this map unit be revisited to complete additional seasonal habitat evaluation?  If yes, which 
ones?  

 

Map Unit Number: Dates of map unit transects: 

Total number of transects:  
Names of transects: 

Total number of photos:  
Aspect of MU:                                          Slope of MU: 

Map Unit Description (1 to 2 sentences describing vegetation, topography, and other features relevant 
to sage-grouse within map-unit): 
  
  
 
   
  

Season during which this map unit was evaluated (circle):     nesting     late brood-rearing     winter 

Indicate potential seasonal habitats in this map unit (circle):     nesting     late brood rearing     winter 

Should this map unit be revisited to complete additional seasonal habitat evaluation?  If yes, which 
ones?  

 

Map Unit Number: Dates of map unit transects: 

Total number of transects:  
Names of transects: 

Total number of photos:  
Aspect of MU:                                          Slope of MU: 

Map Unit Description (1 to 2 sentences describing vegetation, topography, and other features relevant 
to sage-grouse within map-unit): 
  
  
 
   
  

Season during which this map unit was evaluated (circle):     nesting     late brood-rearing     winter 

Indicate potential seasonal habitats in this map unit (circle):     nesting     late brood rearing     winter 

Should this map unit be revisited to complete additional seasonal habitat evaluation?  If yes, which 
ones?  



 

Map Unit Number: Dates of map unit transects: 

Total number of transects:  
Names of transects: 

Total number of photos:  
Aspect of MU:                                          Slope of MU: 

Map Unit Description (1 to 2 sentences describing vegetation, topography, and other features relevant 
to sage-grouse within map-unit): 
  
  
 
   
  

Season during which this map unit was evaluated (circle):     nesting     late brood-rearing     winter 

Indicate potential seasonal habitats in this map unit (circle):     nesting     late brood rearing     winter 

Should this map unit be revisited to complete additional seasonal habitat evaluation?  If yes, which 
ones?  

 

Map Unit Number: Dates of map unit transects: 

Total number of transects:  
Names of transects: 

Total number of photos:  
Aspect of MU:                                          Slope of MU: 

Map Unit Description (1 to 2 sentences describing vegetation, topography, and other features relevant 
to sage-grouse within map-unit): 
  
  
 
   
  

Season during which this map unit was evaluated (circle):     nesting     late brood-rearing     winter 

Indicate potential seasonal habitats in this map unit (circle):     nesting     late brood rearing     winter 

Should this map unit be revisited to complete additional seasonal habitat evaluation?  If yes, which 
ones? 

 

Map Unit Number: Dates of map unit transects: 

Total number of transects:  
Names of transects: 

Total number of photos:  
Aspect of MU:                                          Slope of MU: 

Map Unit Description (1 to 2 sentences describing vegetation, topography, and other features relevant 
to sage-grouse within map-unit): 
  
  
 
   
  

Season during which this map unit was evaluated (circle):     nesting     late brood-rearing     winter 

Indicate potential seasonal habitats in this map unit (circle):     nesting     late brood rearing     winter 

Should this map unit be revisited to complete additional seasonal habitat evaluation?  If yes, which 
ones? 
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Appendix 8: Ability to Control Wildfire Scorecard  



 
 
NEVADA CONSERVATION CREDIT SYSTEM USER’S GUIDE PAGE 78 

CONSERVATION CREDIT SYSTEM USER’S GUIDE  
V1.3_AUTOMATED 

 

ABILITY TO CONTROL WILDFIRE SCORE CARD 
 

Site Name: Date: 

SITE 
CHARACTERISTICS 

SITE CONDITION (select one) SITE SCORE 

Vegetation/Fuel Type/Ignition Risk 
Dominant fuel type in 
project area 
(Fire Behavior Fuel 
Models based on USDA 
Forest Service Gen. Tech. 
Rep. RMRS-GTR-153. 
2005) 

Irrigated pasture (NB3) = 0 
Riparian wet meadow(GR3) = 1 
Perennial Grass (GR1, GR2) = 3 
Shrub (SH1, SH2) = 5  
Grass/Shrub (GS1, GS2) = 7  
Heavy Shrub/Grass (SH5, SH7) = 8 
Pinyon/Juniper (TU4) =10 

 

Dominant fuel type 
adjacent to the project 
area (w/in 1 mile) 

Irrigated (NB3)/Riparian(GR3) = 0 
Perennial Grass (GR1, GR2) = 1 
Shrub (SH1, SH2) = 5  
Shrub/Grass (GS1, GS2) = 7  
Heavy Shrub/Grass (SH5, SH7) = 8 
Pinyon/Juniper (TU4) = 10 

 

Invasive Annual Grass 
Cover 
 (Based on HQT data) 

0% = 0 
1-5% = 5 
>5= 10 
 

 

Vegetation Condition 
Class VCC (departure 
from historic conditions) 
LANDFIRE Map 

Low = 1 
Moderate = 2  
High = 3 

 

Topography/ Access/ Response Time 
Average percent slope in 
project area (GIS) 
 

0-10%  = 1 
11-25% = 3  
greater than 25% = 5 

 

Access to project area for 
suppression resources 

paved road = 1 
improved dirt road = 2 
unimproved two-track = 4 
hike or aircraft = 5 

 

Response Time of Fire 
Suppression Resources 
for Initial Attack 

Less than 1 hour = 1 
1-2 hours = 3 
greater than 2 hours = 5 

 

Average aspect of project 
site (GIS) 

N,NE = 1 
NW, E = 2 
W. SE = 3 
S, SW, Flat = 4 

 

Road Distance to 
Available Water Sources 

<1 mile = 0 
1 to 3 miles = 3 
>3 miles = 5 

 

TOTAL:  
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Appendix 9: Transect Datasheet  
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NEVADA CONSERVATION CREDIT SYSTEM HABITAT QUANTIFICATION TOOL 
 

Revised 06-12-17 (SETT) 

Site-Scale (4th Order) Attribute Measurements 

Site Name: 

Date: Observers: Start time: End time:  

Transect name: Transect UTM E:  Transect UTM N: 

Transect Sample Bearing: GIS/Camera / Photo #'s:  

Is transect located within what would generally be called a meadow?     Yes    No  

What sagebrush species is the transect dominated by?     Big    Low/Black     N/A     

 DISTANCE TO SUITABLE SAGEBRUSH COVER (10% PER 30M X 30M AREA) 

Distance from 30m mark:  

 

*if transect within suitable cover, distance = 0 

 

LINE INTERCEPT (SHRUB COVER) 

  Low/Big Sagebrush/ 
Other 

Start Stop 
Shrub Height 

(cm) 
  

 Low/Big 
Sagebrush/ Other 

Start Stop 
Shrub Height 

(cm) 

        
  

        

        
  

        

        
  

        

        
  

        

        
  

        

        
  

        

        
  

        

        
  

        

        
  

        

        
  

        

        
  

        

        
  

        

        
  

        

        
  

        

        
  

        

        
  

        

        
  

        

        
  

        

        
  

        

        
  

        

        
  

        

        
  

        

        
  

        

        
  

        

 Shrub species encountered along transect: Notes for Line Intercept:  
    

  
    

 



 

 

 

DAUBENMIRE PLOTS (HERBACEOUS COVER)  

Record percent cover using the following coverage classes: 0 = 0%, 1 = >0-5%, 2 = 6-25%, 3 = 26-50%, 4 = 51-75%,  5 = 76-95%, 6 = 
>96% 

PF = Perennial Forbs; PG = Perennial Graminoids; IAG = Invasive Annual Grasses 
   

            Plot # Functional Group Cover Class 

  

Plot # Functional Group Cover Class 

1 

PF   
  4 

PF   

PG   
  

PG   

IAG   
  

IAG   

            Plot # Functional Group Cover Class 

  

Plot # Functional Group Cover Class 

2 

PF   
  5 

PF   

PG   
  

PG   

IAG   
  

IAG   

            Plot # Functional Group Cover Class 

       

3 

PF   
       PG   
       IAG   
                   UNIQUE PERENNIAL & ANNUAL FORBS IN DAUBENMIRE FRAMES: 

List  all unique forb species found across all plots within this transect:  
   

   

 

  
 

  

     

     

     

     

     

     

     

     

TOTAL UNIQUE PERENNIAL & ANNUAL FORBS COUNT: 

Record total number of unique forb species:  
  

 

   

 Total Forbs: 
   

 
   

 
 
Forb and graminoid species encountered along transect: Notes for Daubenmire plots:  
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Appendix 10: Photo Transect Datasheet   
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Project site: 

 

Date: 

 

Transect name: 

 

Transect direction: 
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Appendix 11. Anthropogenic Features Datasheet 
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Project Site Name: Version: SETT 061217 
Marked on map or with GPS unit (circle one). GPS Unit name if applicable: 

 
ANTHROPOGENIC FEATURES 

 

Feature Type Camera/ Photo # Name (if marked 
using GPS) UTM E UTM N Notes 

            
            
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      

 
Notes :   
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For information and questions about the Nevada Conservation Credit System, please contact: 
 
Sagebrush Ecosystem Technical Team (SETT) 
(775) 684-8600  
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	D1.1 In ArcCatalog, create a new folder for the project. Name this folder following the convention ProjectName_YYYYMMDD.
	D1.2 Within the folder, create a new File Geodatabase (.gdb) by right-clicking on the folder and selecting ‘New’ > ‘File Geodatabase’. Give it the same name as the project folder.
	D1.3 Open NV_CCS_Map_Template (.mxd), located in the Nevada Data Package, and save a copy of the map document within the project folder. Give it the same name as the project folder.
	D1.4 If necessary, add the relevant toolbox to ArcToolbox by right-clicking on the parent ArcToolbox  (         ) in the ArcToolbox window and selecting ‘Add Toolbox’. Navigate to the Toolbox and click ‘Open’. The toolbox should now be available in th...
	D1.5 In ArcMap, open the Catalog window (), navigate to the new geodatabase, right click on it and select ‘Make Default Database’.
	You will submit this Project Folder as a zipped folder (.zip) to the Credit System Administrator along with the Project Calculator.

	D2. Run Debit Tool 1
	D3.  Categorize the Type & Subtype of the Proposed_Surface_Disturbance_Debits layer
	D3.1 In the Table of Contents window, right-click on the Proposed_Surface_Disturbance_Debits layer and open the attribute table.
	D3.2 Start an editing session by right-clicking on the Proposed_Surface_Distubance_Debits layer in the Table of Contents and selecting ‘Edit Features > Start Editing’.
	D3.3 Review the features provided by the project proponent, and edit as needed. Ensure that the outer extents of all proposed anthropogenic features are digitized correctly and all pre-populated data is accurate.
	D3.4 Populate or update the ‘Type’ and ‘Subtype’ fields for each feature based on the descriptions in Table 1. The Proposed_Surface_Disturbance file provided by the project proponent will likely contain field codes analogous to the ‘Type’ and ‘Subtype...
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	D5.1 Open the attribute table of the Map_Units layer.
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	D5.3 Using the Cut Polygon tool (  ) in the Editor Toolbar, delineate map units in the Map_Units layer. See Appendix 1. Guidance for Delineating Map Units for detailed information.
	D5.4 Name map units numerically and record the name in the ‘Map_Unit_ID’ field. Map units that appear to be very similar, but not adjacent to each other, can receive the same numerical name and be considered a single map unit. In the field, a visual w...
	D5.5 Name each map unit by providing a short description, typically associated with the major vegetation type, in the ‘Map_Unit_Name’ field.
	D5.6 For any map units that are meadows, populate the ‘Meadow’ attribute with ‘Altered’ or ‘Unaltered’. For all other map units, populate the ‘Meadow’ attribute with ‘No Meadow’.
	D5.7 Populate the ‘Precip’ field for each map unit with the correct precipitation regime from the Precip layer. Record if the map unit falls in the ‘Arid’ or ‘Mesic’ precipitation regime. If a map unit spans both precipitation regimes, record the domi...
	D5.8 Save the edits and stop editing when done.

	D6. Run Debit Tool 3
	D7.  Identify and delineate anthropogenic features
	D7.1 Right click on the layer in the Table of Contents, click ‘Edit Features’, then click ‘Start Editing’. Using editing tools, modify and/or delineate features as needed.
	D7.2 Open the attribute table and populate the ‘Type’ and ‘Subtype’ fields for each entry. Use the Type Code and Subtype Code for each attribute as provided in Table 1. Be sure to save edits and stop editing when done.

	D8.  Acquire the Dist_Lek layer from the Nevada Department of Wildlife (NDOW)
	D8.1 Submit a Data Request Form, available from the NDOW website at http://www.ndow.org/Nevada_Wildlife/Maps_and_Data/Data/.
	D8.2 Provide the Assessment_Area_6000m layer as the ‘Project Extent’. The Assessment_Area_6000m layer is saved as a shapefile in the project folder. Clarify that you are requesting the Dist_Lek layer for the purpose of assessing a project site for the...

	D9.  Run Debit Tool 4
	D10.  Specify number of transects for each map unit
	D10.1 Open the attribute table of the Map_Units_Dissolve layer.
	D10.2 Populate the ‘Transects’ field for each map unit with the number of transects to be sampled within each map unit according to the necessary sampling intensity (see Appendix 2. Recommended Transects per Map Unit). For the map unit associated with...
	D10.3 Save edits and stop editing when done.

	D11.  Run Debit Tool 5
	D12.  Run Debit Tool 6
	D13.  Add the exported data to the Debit Project Calculator
	D13.1 Open the Map_Unit_Data.xls, Transects_Data.xls and Mgmt_Cat_Data.xls files in Excel.
	D13.2 Copy the relevant columns from the tables into the corresponding worksheets and columns in the Project calculator. See Figure 13 for a list of data generated during the Desktop Analysis that must be inputted into the Project HQT Calculator.


	Credit projects that do not propose to modify current anthropogenic features: Guidance for completing the desktop analysis
	C1.  Create project folder, project geodatabase, and map document
	C1.1 In ArcCatalog, create a new folder for the project. Name this folder following the convention ProjectName_YYYYMMDD.
	C1.2 Within the folder, create a new File Geodatabase (.gdb) by right-clicking on the folder and selecting ‘New’ > ‘File Geodatabase’. Give it the same name as the project folder.
	C1.3 Open NV_CCS_Map_Template (.mxd), located in the Nevada Data Package, and save a copy of the map document within the project folder. Give it the same name as the project folder.
	C1.4 If necessary, add the relevant toolbox to ArcToolbox by right-clicking on the parent ArcToolbox  (         ) in the ArcToolbox window and selecting ‘Add Toolbox’. Navigate to the Toolbox and click ‘Open’. The toolbox should now be available in th...
	C1.5 In ArcMap, open the Catalog window (), navigate to the new geodatabase, right click on it and select ‘Make Default Database’.
	You will submit this Project Folder as a zipped folder (.zip) to the Credit System Administrator along with the Project Calculator.

	C2.  Run Credit Tool 1
	C3.  Divide Map_Units layer into discrete map units & populate attribute table
	C3.1 Open the attribute table of the Map_Units layer.
	C3.2 Start an editing session by right-clicking on the layer in the Table of Contents, clicking ‘Edit Features’, then ‘Start Editing’.
	C3.3 Using the Cut Polygon tool (  ) in the Editor Toolbar, delineate map units in the Map_Units layer. See Appendix 1. Guidance for Delineating Map Units  for detailed information.
	C3.4 Name map units numerically and record the name in the ‘Map_Unit_ID’ field. Map units that appear to be very similar, but not adjacent to each other, can receive the same numerical name and be considered a single map unit. In the field, a visual w...
	C3.5 Name each map unit by providing a short description, typically associated with the major vegetation type, in the ‘Map_Unit_Name’ field.
	C3.6 For any map units that are meadows, populate the ‘Meadow’ attribute with ‘Altered’ or ‘Unaltered’. For all other map units, populate the ‘Meadow’ attribute with ‘No Meadow’. Meadow type definitions are provided in the ‘Tips’ below.
	C3.7 Populate the ‘Precip’ field for each map unit with the correct precipitation regime from the Precip layer. Record if the map unit falls in the ‘Arid’ or ‘Mesic’ precipitation regime. If a map unit spans both precipitation regimes, record the domi...
	C3.8 Save the edits and stop editing when done.

	C4.  Run Credit Tool 2
	C5.  Identify and delineate anthropogenic features
	C5.1 Right click on the layer in the Table of Contents, click ‘Edit Features’, then click ‘Start Editing’. Using editing tools, modify and/or delineate features as needed.
	C5.2 Open the attribute table and populate the ‘Type’ and ‘Subtype’ fields for each entry. Use the Type Code and Subtype Code for each attribute as provided in Table 1. Be sure to save edits and stop editing when done.

	C6.  Acquire the Dist_Lek layer from the Nevada Department of Wildlife (NDOW)
	C6.1 Submit a Data Request Form, available from the NDOW website at http://www.ndow.org/Nevada_Wildlife/Maps_and_Data/Data/.
	C6.2 Provide the Assessment_Area_6000m layer as the ‘Project Extent’. The Assessment_Area_6000m layer is saved as a shapefile in the project folder. Clarify that you are requesting the Dist_Lek layer for the purpose of assessing a project site for the...

	C7.  Run Credit Tool 3
	C8. Specify number of transects for each map unit
	C8.1 Open the attribute table of the Map_Units_Dissolve layer.
	C8.2 Populate the ‘Transects’ field for each map unit with the number of transects to be sampled within each map unit according to the necessary sampling intensity (see Appendix 2. Recommended Transects per Map Unit). For the map unit associated with ...
	C8.3 Save edits and stop editing when done.

	C9.  Run Credit Tool 4
	C10.  Run Credit Tool 5
	C11.  Add the exported data to the Credit Project Calculator
	C11.1 Open the Map_Unit_Data.xls, Transects_Data.xls and Mgmt_Cat_Data.xls files in Excel.
	C11.2 Copy the relevant columns from the tables into the corresponding worksheets and columns in the Project calculator. See Figure 24 for a list of data generated during the Desktop Analysis that must be inputted into the Project HQT Calculator.


	Credit projects that propose to modify current anthropogenic features: Guidance for completing the desktop analysis
	CR1.  Create project folder, project geodatabase, and map document
	CR1.1 In ArcCatalog, create a new folder for the project. Name this folder following the convention ProjectName_YYYYMMDD.
	CR1.2 Within the folder, create a new File Geodatabase (.gdb) by right-clicking on the folder and selecting ‘New’ > ‘File Geodatabase’. Give it the same name as the project folder.
	CR1.3 Open NV_CCS_Map_Template (.mxd), located in the Nevada Data Package, and save a copy of the map document within the project folder. Give it the same name as the project folder.
	CR1.4 If necessary, add the relevant toolbox to ArcToolbox by right-clicking on the parent ArcToolbox  (         ) in the ArcToolbox window and selecting ‘Add Toolbox’. Navigate to the Toolbox and click ‘Open’. The toolbox should now be available in t...
	CR1.5 In ArcMap, open the Catalog window (), navigate to the new geodatabase, right click on it and select ‘Make Default Database’.
	You will submit this Project Folder as a zipped folder (.zip) to the Credit System Administrator along with the Project Calculator.

	CR2.  Run Credit Tool Reclaim 1
	CR3.  Identify and delineate anthropogenic features proposed for modification
	CR3.1 In the Table of Contents window, right-click on the Proposed_Modified_Features layer and open the attribute table.
	CR3.2 Start an editing session by right-clicking on the Proposed_Modified_Features layer in the Table of Contents and selecting ‘Edit Features > Start Editing’.
	CR3.3 Review any features that are already delineated, and edit as needed. Ensure that the outer extents of all anthropogenic features proposed for modification are digitized correctly. Delineate additional features as needed.
	CR3.4 Populate the ‘Type’ and ‘Subtype’ fields for each entry. Be sure to save edits and stop editing when done. The ‘Type’ and ‘Subtype’ provided here should reflect the current ‘Type’ and ‘Subtype’ of the feature, not the ‘Type’ and ‘Subtype’ after ...

	CR4. Run Credit Tool Reclaim 2
	CR5.  Divide Map_Units layer into discrete map units & populate attribute table
	CR5.1 Open the attribute table of the Map_Units layer.
	CR5.2 Start an editing session by right-clicking on the layer in the Table of Contents, clicking ‘Edit Features’, then ‘Start Editing’.
	CR5.3 Using the Cut Polygon tool (  ) in the Editor Toolbar, delineate map units in the Map_Units layer. See Appendix 1. Guidance for Delineating Map Units for detailed information.
	CR5.4 Name map units numerically and record the name in the ‘Map_Unit_ID’ field. Map units that appear to be very similar, but not adjacent to each other, can receive the same numerical name and be considered a single map unit. In the field, a visual ...
	CR5.5 Name each map unit by providing a short description, typically associated with the major vegetation type, in the ‘Map_Unit_Name’ field.
	CR5.6 For any map units that are meadows, populate the ‘Meadow’ attribute with ‘Altered’ or ‘Unaltered’. For all other map units, populate the ‘Meadow’ attribute with ‘No Meadow’. Meadow type definitions are provided in the ‘Tips’ below.
	CR5.7 Populate the ‘Precip’ field for each map unit with the correct precipitation regime from the Precip layer. Record if the map unit falls in the ‘Arid’ or ‘Mesic’ precipitation regime. If a map unit spans both precipitation regimes, record the dom...
	CR5.8 Save the edits and stop editing when done.

	CR6.  Run Credit Tool Reclaim 3
	CR7.  Identify and delineate anthropogenic features
	CR7.1 Right click on the layer in the Table of Contents, click ‘Edit Features’, then click ‘Start Editing’. Using editing tools, modify and/or delineate features as needed.
	CR7.2 Open the attribute table and populate the ‘Type’ and ‘Subtype’ fields for each entry. Use the Type Code and Subtype Code for each attribute as provided in Table 1. Be sure to save edits and stop editing when done.

	CR8.  Acquire the Dist_Lek layer from the Nevada Department of Wildlife (NDOW)
	CR8.1 Submit a Data Request Form, available from the NDOW website at http://www.ndow.org/Nevada_Wildlife/Maps_and_Data/Data/.
	CR8.2 Provide the Assessment_Area_6000m layer as the ‘Project Extent’. The Assessment_Area_6000m layer is saved as a shapefile in the project folder. Clarify that you are requesting the Dist_Lek layer for the purpose of assessing a project site for th...

	CR9.  Run Credit Tool Reclaim 4
	CR10.  Specify number of transects for each map unit
	CR10.1 Open the attribute table of the Map_Units_Dissolve layer.
	CR10.2 Populate the ‘Transects’ field for each map unit with the number of transects to be sampled within each map unit according to the necessary sampling intensity (see Appendix 2. Recommended Transects per Map Unit). For the map unit associated wit...
	CR10.3 Save edits and stop editing when done.

	CR11.  Run Credit Tool Reclaim 5
	CR12.  Run Credit Tool Reclaim 6
	CR13.  Add the exported data to the Credit Project Calculator
	CR13.1 Open the Map_Unit_Data.xls, Transects_Data.xls and Mgmt_Cat_Data.xls files in Excel.
	CR13.2 Copy the relevant columns from the tables into the corresponding worksheets and columns in the Project calculator. See Figure 31 for a list of data generated during the Desktop Analysis that must be inputted into the Project HQT Calculator.


	TIMING OF FIELD DATA COLLECTION
	FIELD MATERIALS REQUIRED
	DETAILED INSTRUCTIONS
	F1. Conduct Site Reconnaissance
	F2. [Repeat Steps F3 - F9 for each Map Unit]
	F3. Complete Map Unit Datasheet
	F4. Complete Resistance & Resilience Scorecard
	F5. Complete Ability to Control Wildfire Scorecard
	F6. Complete Lentic or Lotic PFC Checklist (if applicable)
	F7. [Repeat Steps F8 - F9 for each Transect]
	F8. Navigate to Transect and Begin Data Collection
	F8.1 Establishing a Transect
	F8.1(a) Navigate to a transect start point via hand-held GPS. Insert a chaining pin in the ground, and lay out or thread a 50-meter transect using the random bearing generated for that transect. Pull the tape taut and anchor the 50 m end with a chaini...
	F8.1(b) Transects will be named as followed: XXX-MU#-T#
	F8.1(c) XXX is three letter abbreviation for project site, MU# is the map unit number, and T# is the transect number, all of which should be named based on information from the pre-field work desktop analysis.
	F8.2 Photo Points
	F8.2(a) Using a white board label it with the project site, date, transect name, and transect direction. Lean it next to the chaining pin it at the 0 meter mark of the transect.
	F8.2(b) Align camera in direction of the transect so that the bottom of the white board is at the photo’s bottom center (Figure 32).
	F8.2(c) Take photo and, if using GPS camera, name the photo using transect name.

	F9. Daubenmire Plots
	F9.1 Daubenmire Frame Placement
	F9.1(a) Place the top of a Daubenmire frame on the left side of the transect line starting at the 10 meter mark (see Figure 33). The frame should be placed with the long side parallel to the transect.  Take care not to damage any vegetation. Repeat th...
	F9.2 Grass and Forb Cover
	F9.2(a) Record all grass and forb cover that falls within the plot using the following cover classes listed in Table 3. If the plant is rooted outside the plot, but its cover falls within the plot, those estimates should be counted towards cover. Do n...
	F9.2(b) Identify cover for each of the following functional group categories:
	F9.3 Forb Species Count
	F9.3(a) For each Daubenmire plot, record the USDA PLANT code or scientific name for each forb species that are rooted within the plot, annual and perennial. Once all 5 plots are completed for a transect, tally and record the count of all forb species ...
	F9.3(b) Record all plant species encountered along the transect in the notes section of the datasheet.

	F10. Distance to Sagebrush Cover
	F10.1 Measure the distance to the nearest sagebrush, or sagebrush mixed shrub community, cover from the 30 m mark of the transect and record the distance in meters on the datasheet.
	F10.1(a) Sagebrush or sagebrush mixed shrub community cover must have at least of 10% canopy cover in a minimum 30x30 m patch size with average height of 30 cm.
	F10.1(b) If the transect is located within sagebrush cover, then record distance as 0 m.

	F11. Line Intercept
	F11.1 Shrub Canopy Cover
	F11.1(a) You can begin at the 0 m or the 50 m mark for line intercept. For the entire length of the transect, record start and stop locations (in centimeters) for all shrub species intercepting the transect using the following categories:
	F11.1(b) Interceptions less than 5 cm are not recorded as canopy cover.
	F11.1(c) If a gap is greater than 5 cm stop your intercept recording. Resume intercept once you reach canopy cover that is greater than 5 cm.
	F11.1(d) Canopy cover for each shrub species is recorded, even if multiple species are overlapping.
	F11.2 Sagebrush Height
	F11.2(a) For each sagebrush plant intercepting the transect, record the tallest vegetative portion to the nearest cm. Do not include the inflorescence of sagebrush as height.

	F12. Document Anthropogenic Features
	F12.1 The anthropogenic features map developed in the pre-field desktop analysis should be ground-truthed on foot or in a vehicle.  Additional features that are identified should be marked on the map and digitized in the office in ArcGIS; similarly GP...
	F12.2 Newly identified features should be noted on the anthropogenic features datasheet for the project site.
	F12.2(a) If features are marked on the map, be sure to attach map to the anthropogenic features datasheet.
	F12.2(b) If features are marked using GPS, be sure to record GPS unit name and use the following naming code: XXX- # where XXX is the three letter abbreviation for project site, and # is a unique sequential number for each feature identified in the fi...

	F13. Input Data into Credit or Debit Project Calculator
	F13.1 Open the Project Calculator.
	F13.2 Enter the relevant data into the corresponding worksheets and columns in the Calculator. See Table 4 for a list of field datasheets completed during the field data collection that must be inputted into the Calculator.


	TOOL PREREQUISITES
	DETAILED STEPS TO CALCULATE CREDITS
	D2.1 Calculate Pre-Project Conditions
	D2.1.1 Calculate Credits for Pre-Project Conditions
	Open the Credit Project Calculator.
	Review habitat function and functional acre scores based on current conditions presented in worksheet 3.2 Review Credit/Debit Amount to ensure data has been inputted accurately. If not, review Section 1: Desktop Analysis or Section 2: Field Data Colle...
	Enter relevant WAFWA Management Zone and factors that determine the reserve account contribution into worksheet 3.1 Enter Baseline & Rsrv Acct.
	Conduct quality assurance effort by thoroughly reviewing the GIS process and products, baseline habitat function, current habitat function, current functional acres, current mitigation ratio and current credits generated values in worksheet Summary to...


	D2.2 Define & Submit Project Design Information
	D2.2.1 Complete Section I of the Management Plan
	Complete Section I of the Management Plan according to guidance provided in the form. For restoration or enhancement projects, use a draft Management Plan to outline design options for the project and describe expected outcomes. These design options w...

	D2.2.2 Estimate Post-Project Credits
	In the Calculator, estimate post-project credits by entering projected post-project conditions based on project design options in the Management Plan into worksheet 2.7 Enter Projected Conditions.
	Projected post-project conditions are entered into the Projected Post-Project Habitat Function and Projected Post-Project Mitigation Ratio data entry columns. For cells left blank in these data entry columns, the current conditions are used for calcul...

	Review the projected post-project credit calculations in worksheet Summary.
	Print the updated Credit Summary from worksheet Summary and copy/paste Credit Summary into the corresponding section of the draft Management Plan.


	D2.3 Implement Project, Refine Calculations & Submit
	D2.3.1 Confirm or Refine Credit Calculations
	Implement the project and repeat the credit calculation if the project was not consistent with the draft Management Plan. Modify the Calculator and repeat steps in the Desktop Analysis if necessary. This is the final, official credit calculation. If c...

	D2.3.2 Determine Reserve Account Contribution
	Enter the area-weighted Resistance and Resilience scores from the Score Sheets completed in step F4 into worksheet 3.1 Enter Baseline & Rsrv Acct of the Calculator.
	Enter the area-weighted Ability to Control Wildfire Score Sheet score for the credit project.
	Complete the Competing Land Use assessment and input contribution percentage from Table 5 for projects on private land into Worksheet 3.1 Enter Baseline & Rsrv Acct of the Calculator. See the Management Plan for information necessary to complete the C...

	D2.3.3 Determine Credit Release Schedule
	Review the pre-project credit calculation to the expected post-project credit calculation in worksheet Summary.  Use this information to fill out the Credit Release Schedule in Section II of the Management Plan.

	D2.3.4 Calculate Financial Assurances
	Complete the management actions table in Section III of the Management Plan to estimate the cost for long-term management of the credit project. Use this section to determine the amount required for financial assurances for the project. Fill out Secti...

	D2.3.5 Set Verification Schedule
	Complete the independent verification schedule in Section III of the Management Plan.

	D2.3.6 Complete Participant Contract
	Fill out and sign the Participant Contract.



	DETAILED STEPS TO CALCULATE CREDIT OBLIGATION
	B2.1 Determine Credit Obligation Amount
	B2.1.1 Establish Verification Contract
	Complete a Verification Contract with the Credit Buyer.

	B2.1.2 Estimate Credit Obligation
	Open the Debit Project Calculator.
	Review all tabs to ensure data has been inputted accurately. If not, review Section 1: Desktop Analysis or Section 2: Field Data Collections Methods for instructions.
	In the Debit Project Calculator, review preliminary credit obligation calculation in worksheet Summary. This is the pre-implementation credit obligation estimate.

	D2.1.3 Verify Debit Estimates
	If field data was collected by the Credit Buyer, verify that field data collection was completed accurately.

	D2.1.4 Verify Post-Project Conditions
	After the project has been implemented, verify that project design plans were followed and that the original credit obligation estimate is still accurate. If not, repeat Desktop Analysis steps necessary to recalculate credit obligations based on actua...

	D2.1.5 Purchase Credits
	The Credit Buyer will be provided a list of credit projects that could meet the Credit Buyer’s credit obligation. The Credit Buyer then selects one or more potential credit projects and contacts the Credit Developer. The Credit Developer and Credit Bu...
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